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ANOTACE 

 

Bakalářská práce Periodické analýzy a vizualizace dat pro Hasičský záchranný 

sbor Zlínského kraje v rešeršní části zkoumá aktuální stav využívání Geografických 

informačních systémů na krajských pracovištích hasičských záchranných sborů 

na území České republiky. Popisuje strukturu hasičských záchranných sborů 

a informuje o datech, které mají hasiči k dispozici, o GIS aplikacích a mapách, které 

používají. 

V praktické části popisuje sestavení dvou typů toolboxů v prostředí Model 

Builder. První typ toolboxu bude sloužit pro periodické vyplnění tabulek zásahových 

obvodů pro účely Hasičského záchranného sboru Zlínského kraje.  

Druhý typ je určen pro vytvoření ořezů vybraných vrstev podle katastrálního 

území každé obce ve Zlínském kraji. Model pro ořezání vrstev je doplněn o skript 

pro roztřídění vrstev a vyexportování map ve formátu pdf. Tyto mapy jsou použity 

pro vytvoření karet obcí. 

Karty obcí jsou navíc doplněny o základní informace o obci a její vybavenosti. 

Uvedeny jsou i kontakty na starostu obce a velitele jednotky požární ochrany v dané 

obci.  
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ANOTATION 
Bachelor thesis „Periodic data analysis and visualization for the Fire rescue 

service of the Zlín region” in the search section examines the current status of the use 

of Geographic Information Systems for regional offices Fire rescue service in the Czech 

Republic. Describes the structure of fire departments and informs about the data that 

have firefighters available, about GIS applications and maps that use. 

The practical part describes the preparation of two types of toolboxes in the 

Model Builder. The first type of toolbox will be used to create tables for the Fire rescue 

service of the Zlín region. 

The second type of toolbox will be to use to create extracts input layers that 

overlap with the cadastral area of each municipality in the region. Model for create 

extracts is complemented by a script to categorize output layers to projects mxd and 

exported maps in pdf format. These maps are used to create cards municipalities. 

Cards municipalities are also accompanied by basic information about the 

village and its amenities. The cards contain also contacts for the mayor and commander 

of fire protection units in the municipality. 
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SEZNAM POUŽITÝCH ZKRATEK 

 

Zkratka Význam 

AČR Armáda České republiky 

CDS Centrální datový sklad 

CEDA Central European Data Agency, a. s. 

CMYK Cyan Magenta Yellow Key (blacK) (subtraktivní barevný model)  

ČD České dráhy 

ČSÚ Český statistický úřad 

ČÚZK Český úřad zeměměřický a katastrální 

DGN Design (souborový formát)  

DIBAVOD Digitální báze vodohospodářských dat 

ESRI Environmental System Research Institute  

ETL Extract Transform Load 

GIS  Geografický informační systém 

GIT Geoinformační technologie 

GPS Globální polohový systém 

HZS Hasičský záchranný sbor 

IDE Integrated Development Environment 

IOO Institut ochrany obyvatelstva 

ISKŘ Informační systém Krizového řízení 

IZS Integrovaný záchranný systém 

JEDU Jaderná elektrárna Dukovany 

JETE Jaderná elektrárna Temelín 

JPO Jednotka požární ochrany 

MVČR Ministerstvo vnitra České republiky 

ORP Obec s rozšířenou působností 

PC Personal Computer 

PČR Policie České republiky 

PDF Portable Document Format (souborový formát) 

por. poručík 

RGB Red Green Blue (aditivní barevný model) 

RIA Rich Internet Application 

RÚIAN Registr územní identifikace, adres a nemovitostí 

ŘSD Ředitelství silnic a dálnic 

SHP Shapefile 

SOA Service Oriented Architecture 

SQL Structured Query Language 

SW Software 

SŽDC Správa železniční dopravní cesty 
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Zkratka Význam 

TCTV Telefonní centrum tísňového volání 

ÚHÚL Úřad pro hospodářskou úpravu lesů 

VO Veřejné osvětlení 

VÚV TGM Výzkumný ústav vodohospodářský Tomáše Garigue Masaryka 

ZABAGED® Základní báze digitálních dat 

ZZS Zdravotní záchranná služba 
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ÚVOD 

Hasičský záchranný sbor je složen nejen z hasičů, kteří zachraňují lidské životy, 

zvířata, majetek a jsou připraveni kdykoliv k nasazení svých životů, ale i z pracovníků, 

kteří mají velmi důležitou roli v případě řešení mimořádných událostí většího rozsahu 

a k tvorbě podpůrných materiálů. 

Tito pracovníci připravují datové podklady pro využití v případě přírodních 

či jiných katastrof. Je velmi důležité, aby byli připraveni na tyto situace a měli přehled 

o lidech, kteří by mohli být daným problémem ohroženi (počet obyvatel obce, počet 

zaměstnanců velkých firem, počet studentů navštěvujících školní zařízení v obci, …) 

a zda se v zasažené lokalitě nacházejí nebezpečné objekty, které by mohli 

např. kontaminovat své okolí a tím ještě více ohrozit obyvatele atd. 

Veškeré problémy je nutné řešit velmi rychle, protože právě čas je rozhodujícím 

faktorem, mnohdy mezi životem a smrtí. Rychlé nasazení záchranných složek je bráno 

za automatické. Práce na přípravě podpůrných materiálů je někdy ovšem zdlouhavá. 

V případě některých pravidelných analýz nad daty se jedná o práci i na několik dní 

nebo týdnů.  

Základním softwarovým řešením geografických informačních systémů 

využívaných v rámci hasičských záchranných sborů je program ArcGIS. Pro usnadnění 

některých analýz lze sestavit speciální nástroje v prostředí Model Builder. Dílčí kroky 

analýz lze spojit do jednoho nástroje, který práci značně urychlí. Právě tato vize byla 

motivací pro sestavení dvou typů toolboxů obsahující modely, které zajistí pravidelné 

vyplnění tabulek zásahových obvodů a vytvoření ořezů vybraných vrstev. 

V rámci bakalářské práce byla zahájena spolupráce na řešené problematice 

s Hasičským záchranným sborem Zlínského kraje. 
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1 CÍLE PRÁCE 

Cílem bakalářské práce je v prostředí ArcGIS sestavit model, který umožní 

opakovaně provádět datové analýzy a vizualizace vybraných dat, které využívá Hasičský 

záchranný sbor Zlínského kraje. V rešeršní části práce bude zhodnocen současný stav 

využívání geoinformačních technologií a služeb v hasičských záchranných sborech 

v České republice.  

Před praktickou částí bude zjištěn stav dat a samotné požadavky na vytvářené 

datové analýzy a vizualizace. V další fázi bude navržen nejprve vhodný datový model 

a dále nástroj v prostředí Model Builder, který umožní pro jednotlivé obce provádět 

analýzy a vizualizace opakovaně s cílem vyšší efektivity a úspory času. Tento nástroj 

zajistí opakované vyplnění tabulky zásahových obvodů požárních stanic ve Zlínském 

kraji. Toolbox bude rozdělen na více částí, které budou obsahovat dílčí modely.  

Vedle sestaveného nástroje budou výsledkem práce také mapové výstupy 

a tzv. "karty obcí". Mapové podklady budou sestaveny pomocí dalšího modelu 

pro vytvoření ořezů vrstev podle katastrálního území obcí a skriptu v programovacím 

jazyce Python. Tento skript roztřídí ořezy k příslušným obcím, vloží je do projektů mxd 

a vyexportuje mapy ve formátu pdf. Karty obcí budou následně o mapové výstupy 

doplněny. Mimo jiné budou obsahovat základní informace o obci a její vybavenosti 

a kontakty na pověřené osoby. 

Výsledky práce urychlí vytváření výše zmíněných analýz nad daty. Budou 

poskytnuty s uživatelskou příručkou Hasičskému záchrannému sboru Zlínského kraje. 

Nedílnou součástí bude vytvoření webové stránky o bakalářské práci a jejich 

výsledcích. Vše bude v souladu s pravidly dostupnými na stránkách katedry.  
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2 METODY A POSTUPY ZPRACOVÁNÍ 

2.1 Použitá data  

Data k praktické části bakalářské práce byla poskytnuta Hasičským 

záchranným sborem Zlínského kraje po konzultaci s paní Ing. et Bc. Janou Štěpánů 

z oddělení komunikačních a informačních služeb.  

Vrstvy byly vybrány s ohledem na požadavky k vytvoření příslušného modelu. 

Jedná se o soubor 11 vrstev z různých datových balíků. Ve výběru se objevily vrstvy 

ze Základní báze geografických dat (ZABAGED®) od Českého úřadu zeměměřičského 

a katastrálního (ČÚZK) v měřítku 1 : 10 000, z Českého statistického úřadu (ČSÚ) 

z datové sady generalizovaných vrstev Paket 50 v měřítku 1 : 150 000, záplavové území 

od Výzkumného ústavu vodohospodářského T. G. Masaryka (VÚV TGM) z Digitální báze 

vodohospodářských dat (DIBAVOD) v měřítku 1 : 10 000. Vrstva hasebni_obvod_ku byla 

vytvořena paní Ing. et Bc. Janou Štěpánů. Vrstvy HZSZLK_JPO_2014 

a GEN_SilniceDalniceUlice byly původně poskytnuty z Centrálního datového skladu 

(CDS) Institutu ochrany obyvatelstva (IOO) v Lázních Bohdaneč. Pro účely bakalářské 

práce byly zapůjčeny na základě Protokolu o poskytnutí dat, kde jsou definovány 

podmínky jejich využití (viz Příloha 1). 

Všechny vrstvy byly ve formátu shp (shapefile) a zobrazovaly území v rozsahu 

od celé České republiky po Zlínský kraj. Data byla aktuální z druhé poloviny roku 2014. 

Pro účely tvorby ořezů a výsledných map byly do modelu použity další dvě 

vrstvy, a to vodních toků a jezer. Tyto vrstvy byly zdarma poskytnuty 

z Hydroekologického informačního systému VÚV TGM (viz Tab. 2).  

 

Tab. 1 Základní charakteristika dat použitých v praktické části (1. typ modelu). 

Vrstva Typ Rozsah území 

HZSZLK_JPO_2014 bodová Zlínský kraj 

GEN_SilniceDalniceUlice liniová Zlínský kraj 

ZBGD_ZeleznicniTrat liniová Česká republika 

CSU_SV_orp polygonová Česká republika (mimo Prahu) 

CSU_US_lau1 polygonová Česká republika 

CSU_US_obce polygonová Česká republika 

hasebni_obvod_ku polygonová Zlínský kraj 

VUV_D03_ZaplUzemi100Vody polygonová Česká republika 

ZBGD_BudovaBlokBudov polygonová Zlínský kraj 

ZBGD_LesniPudaSeStromy polygonová Česká republika 

ZBGD_LesniPudaSKrovinatymPorostem polygonová Česká republika 

 

Tab. 2 Doplňující data použitá v rámci 2. typu modelu 

Vrstva Typ Rozsah území 

E_ISVS$UPOV_J.shp polygonová Česká republika 

E_ISVS$UPOV_R.shp liniová Česká republika 
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2.2 Použité metody 

Při tvorbě teoretické části bakalářské práce byla použita metoda rešerše 

literatury doplněná o dotazníkové šetření. Nejdůležitějšími tituly byly články týkající se 

dané problematiky a příspěvky z konferencí (viz Seznam použité literatury). 

V rámci praktické části byla použita nejprve metoda programování (modelování 

a skriptování). Modelování bylo prováděno v prostředí Model Builder, skriptování 

v programovacím jazyce Python. Při modelování byly zapracovány parametry, které 

umožní práci s modelem i při změně názvu vstupních dat a atributů. 

Další využitou metodou byla metoda vizualizace. Výstupní vrstvy z modelů byly 

použity pro tvorbu map pro karty obcí. Pro tyto mapy bylo zvoleno jednotné měřítko 

1 : 30 000.  

2.3 Použité programy  

Při tvorbě bakalářské práce byly použity následující programy: 

 ArcGIS 

 INKSCAPE 

 PyScripter for Python 2.4 

 Microsoft Office 365 - Word 2013, Excel 2013 

 

ArcGIS 

ArcGIS je software poskytovaný americkou společností ESRI (Environmental 

System Research Institute). Umožňuje editovat, provádět různé analýzy, modelovat 

a komplexně spravovat data.  

xistuje v několika verzích a jsou poskytovány tři základní typy licencí. Pro účely 

bakalářské práce byla použita verze ArcGIS 10.1 a následné doladění modelů na verzi 

ArcGIS 10.0, kterou má k dispozici Hasičský záchranný sbor Zlínského kraje. 

 

Model Builder 

„Aplikace Model Builder, která je standardní součástí software ArcGIS for 

Desktop, představuje jednu z možností jak vytvářet vlastní geoprocessingové nástroje 

formou tzv. modelů …“ (ARCDATA PRAHA, 2013). 

Tato aplikace je využívána nejčastěji v případě, kdy je zapotřebí zautomatizovat 

určitou opakující se úlohu, která se skládá z několika po sobě jdoucích operací. „Hlavní 

výhodou vytváření nástrojů v Model Builder je především v rychlosti a jednoduchosti …“ 

(ARCDATA PRAHA, 2013). 

 

PyScripter for Python 2.4 

 PyScripter je open-source řešení pro Python IDE (Integrated Development 

Environment). V tomto nástroji je možné přehledně vytvářet skripty, které lze využít 

i v prostředí ArcGIS.  

 Existuje ve dvou verzích, pro 32bitové a 64bitové operační systémy. Verze 

pro 64bitový operační systém byla využita pro tvorbu skriptu k bakalářské práci. 

 



15 

INKSCAPE (0.48.5) 

INKSCAPE je open-source vektorový grafický editor. Vývojářem tohoto softwaru 

je The Inkscape Team. Program zvládá všechny základní operace pro úpravu mapových 

výstupů a vyrovná se tak známějším grafickým editorům jako je Corel, Adobe 

Illustrator, atd. Byl použit při tvorbě karet obcí.  

 

2.4 Postup zpracování 

Počátečním krokem bylo zahájení spolupráce s Hasičským záchranným sborem 

Zlínského kraje. Kontaktní osobou se stala paní por. Ing. et Bc. Jana Štěpánů, 

referentka pro geografické informační služby. Nejprve byla prokonzultována 

problematika a požadavky na tvorbu toolboxu. Následně byla z jejich strany zapůjčena 

data pro účely bakalářské práce. 

Pro zjištění současného stavu využívání geografických informačních systémů 

a technologií u HZS v ČR byly rozeslány elektronické dotazníky na každé krajské 

pracoviště. Dotazník byl koncipován do čtyř tematických částí. Následně proběhlo 

prostudování literatury na danou tématiku a byla sepsána rešeršní část k bakalářské 

práci.  

Dalším krokem bylo podrobnější seznámení se s rozhraním Model Builder. Zde 

byly postupně sestavovány všechny modely, které byly následně rozděleny do dvou 

toolboxů.  

Během sestavování modelů nastala řada problémů, které byly konzultovány 

s panem Mgr. Filipem Jungem. Kromě řešení problémů s funkčností modelů, byla 

konzultována i tvorba skriptu v programovacím jazyce Pythonu pro roztřídění vrstev 

do jednotlivých projektů mxd a vyexportování výsledných map ve formátu pdf. 

Po obdržení odpovědí z rozeslaných dotazníků byly tyto výsledky zpracovány 

do přehledových tabulek doplněných o komentáře a postřehy. 

Předposledním krokem byla tvorba karet obcí. Nejprve byly shromážděny 

potřebné informace o každé obci a následně společně s mapou vytvořenou skriptem 

vloženy do nachystané šablony. 

Dotazníkové šetření je podrobněji popsáno v kapitole 4, tvorba toolboxů 

v kapitole 5 a karty obcí v kapitole 6. 

Posledním krokem bylo stylistické doladění bakalářské práce a tvorba webových 

stránek. 
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Obr. 1 Diagram postupu zpracování 
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3 SOUČASNÝ STAV ŘEŠENÉ PROBLEMATIKY 

3.1 Hasičský záchranný sbor 

„Ve výčtu složek záchranného systému rozhodně nesmíme zapomenout 

na hasičské záchranné sbory, protože právě hasiči přichází do styku s bezpečnostními 

riziky nejčastěji.“ (Souček, 2010) 

„Hasiči jsou přítomni téměř u každé situace, která ohrožuje životy, majetek nebo 

životní prostředí.“ (Leitgebová a Petr, 2014a) Při výkonu své práce se setkávají 

s nejrůznějšími přírodními živly a pomáhají odstraňovat jejich následky. V klimatických 

podmínkách ČR se jedná nejčastěji o povodně, vichřice nebo následky sněhové 

kalamity. Zasahují ale i při únicích nebezpečných látek. „Nejvíce hasiči pomáhají 

při technické pomoci a dopravních nehodách. Na celkovém počtu událostí se v současné 

době požáry podílí „pouze“ 20%.“ (Leitgebová a Červenka, 2014a) 

„Aby docházelo k co nejrychlejší a nejefektivnější záchraně, mají hasiči 

k dispozici různé podpůrné vybavení. Mezi takové „vybavení“ patří i geografický 

informační systém (GIS).“ (Leitgebová a Petr, 2014a) 

3.1.1 Struktura HZS ČR 

„Hasičský záchranný sbor ČR tvoří generální ředitelství HZS ČR, které je 

součástí Ministerstva vnitra, hasičské záchranné sbory krajů a Střední odborná škola 

požární ochrany a Vyšší odborná škola požární ochrany ve Frýdku-Místku.“ 

(Organizační struktura, 2012) Do základní organizační struktury HZS ČR dále patří 

organizace a zařízení, jako je např. Školící a vzdělávací zařízení v Brně ve Frýdku-

Místku, Institut ochrany obyvatelstva Lázně Bohdaneč, Technický ústav požární 

ochrany v Praze a Skladové a opravárenské zařízení v Olomouci (viz Příloha 2). 

3.1.2 Struktura HZS Zlínského kraje 

Krajské ředitelství HZS Zlínského kraje sídlí ve Zlíně. Organizační struktura HZS 

Zlínského kraje je složena z ředitele HZS, ředitele kanceláře a náměstků, kteří 

zodpovídají za příslušné odbory a oddělení (viz Příloha 3). Do obecné struktury patří 

i územní odbory. V tomto případě se jedná o územní odbor Zlín, Kroměříž, Vsetín 

a Uherské Hradiště. Každý územní odbor je složený z vlastního vedení, které se 

zodpovídá krajskému ředitelství a jednotlivých stanic, které pod daný územní odbor 

spadají. 

3.2 GIS u HZS 

„Geografické informační systémy u Hasičského záchranného sboru ČR patří 

do oblasti informačních systémů, které pomáhají ke správnému a včasnému 

rozhodování a tím i chránit lidské zdraví, život a majetek.“ (GIS portál HZS ČR, 2014) 

V současnosti mají tyto systémy široké pole působnosti a jsou využívány 

v různých oblastech činnosti HZS ČR. „Primární použití GIS je na operačním středisku. 

Důležitá je proto rychlost vykreslování, průběžná aktualizace a co největší uživatelská 

přívětivost se zachováním maximálního množství informací.“ (Leitgebová a Petr, 2014a) 

Pro své účely je využívá nejen operační řízení a pracovníci přijímající tísňová 

volání na TCTV 112 (Telefonním centru tísňového volání 112), ale i krizové řízení. 

Nástroje GIS umožňují modelovat nebezpečné situace a poskytují tak podklady 
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pro vypracování krizových a havarijních plánů. Slouží i k ochraně obyvatelstva nebo 

jako podpora jednotek u zásahu. „Specialisté GIS navrhují optimální rozmístění 

výjezdových stanic a poloha jednotlivých vozidel je sledována prostřednictvím přijímačů 

GPS.“ (Souček, 2010) 

Geografické informační systémy jsou také důležitými pomocníky při řešení 

různých analýz a při vyhledávání potřebných informací v datech, které mají pracovníci 

HZS ČR k dispozici. Mimo to pracovníci s GIS u HZS ČR získaná data vhodně upravují, 

průběžně aktualizují a vytvářejí speciální mapy nejen pro vlastní potřebu, 

ale pro potřeby celého Integrovaného záchranného systému. Tyto mapy jsou jedinečné 

svým tematickým obsahem a nenahraditelné jakýmkoli jiným komerčním mapovým 

dílem či produktem. Umožňují poskytnout účinnou pomoc při řešení mimořádných 

situacích (Leitgebová a Červenka, 2014a). 

Ve Výroční zprávě Komise GIS HZS ČR 2009 - 2012 je zmíněno, jak pomáhaly 

mapy na Liberecku při povodních v roce 2010. „Tištěné mapové podklady zasažených 

obcí byly s podrobností na čísla popisná. Formát byl zvolen A2. Tyto mapy v terénu 

pomáhaly při řešení situace, kdy se střídaly jednotky, které neznaly situaci v obci. 

Od 8. 8. do 13. 8. 2010 bylo vytištěno přes 900 map. Přibližně 80 % využily jednotky 

HZS, zbylých 20 % využívala Armáda ČR, Policie ČR a jednotlivé obce. Pro krizový štáb 

HZS Libereckého kraje byly vytvořeny specifické mapy - orientační letecká mapa 

pro ZZS, mapa pro statiky, mapa pro pyrotechniky k plánování odstřelů nebo mapa 

rozdělení povodňových sektorů. Další analytickou úlohou bylo vytvoření mapy 

zasažených obcí dle intenzity škod.“ 

Při povodních nepomáhají pouze mapy. Bývá využito i modelace tohoto jevu. 

Hydrologické modely vytvářené v prostředí GIS za použití digitálního modelu terénu 

v mapě vyznačí záplavová území. Je tak upozorněno nejen na objekty, které jsou 

povodněmi ohroženy, ale i na potenciální riziko, které může jejich zaplavení způsobit 

(čerpadla pohonných hmot, sklady jedovatých látek atp.).  

„Aplikace dále umožňuje výpočet postižené oblasti vzhledem k danému 

kritickému místu na mapě s možností ohledání zájmových objektů a výpočtem 

statistických informací vypovídajících o stavu analyzovaného území z pohledu počtu 

a věkového složení obyvatelstva.“ (Souček, 2010)  

3.2.1 Historie GIS u HZS 

GIS u HZS ČR jsou využívány více než 10 let. „Začátky využívání GIS u HZS ČR 

jsou úzce svázány s výstavbou systému Telefonního centra tísňového volání TCTV 112. 

O výstavbě systému bylo rozhodnuto v roce 2001.“ (Leitgebová a Červenka, 2014a) 

V počátcích se HZS potýkalo s řadou problémů. Jedním z nich byl nedostatek 

odborníků, kteří pracovali v oblasti GIS. Tito pracovníci byli nerovnoměrně rozmístěni 

v rámci HZS ČR a každý z nich měl různé zkušenosti (Leitgebová a Červenka, 2014a).  

3.3 Komise GIS 

S cílem koordinovat snahu o zavádění geografických informačních systémů 

u HZS ČR byla sestavena Komise GIS. První jednání se uskutečnilo v druhé polovině 

roku 2003, brzy po jejím vzniku 21. července. 

Komise GIS HZS ČR se schází několikrát během roku. „Tato komise je složená 

ze specialistů GIS jednotlivých HZS krajů a generálního ředitelství HZS ČR.“ (Svitáková, 

2012) Koordinuje tvorbu a provozování GIS u HZS ČR, rozhoduje v mnoha záležitostech 

týkajících se aktuálních problémů, geografických dat a jejich správy.  
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3.4 Centrální datový sklad 

Hasičský záchranný sbor potřebuje specifické informace. Z toho důvodu má 

k dispozici velké množství dat, které jsou uloženy v Centrálním datovém skladu, který 

sídlí v Institutu ochrany obyvatel v Lázních Bohdaneč.  

Jeho pracovníci se starají nejen o samotný datový sklad a zpracování dat, 

ale i o jejich distribuci na krajská pracoviště. Data nejsou určena jen pro HZS ČR a GIS 

TCTV 112, ale jsou distribuována i dalším složkám IZS jako je PČR, ZZS nebo MVČR 

(GIS HZS ČR, 2012). 

3.4.1 Historie a důvody vzniku CDS 

Centrální datový sklad vděčí za svou dnešní podobu vytrvalému a aktivnímu 

přístupu Hasičského záchranného sboru České republiky (HZS ČR). Po roce 2003, kdy 

vznikla Komise GIS, se před jejími pracovníky objevily otázky, které byly zcela zásadní 

a byly potřeba zodpovědět. Jednalo se především o řešení témat spjatých 

s poskytováním a získáním dat (Leitgebová a Červenka, 2014a). Komise GIS vyjednávala 

s poskytovateli geografických dat v České republice. Výsledkem jednání a následné 

spolupráce je unikátní datová sada z produkce několika subjektů a její pravidelná 

aktualizace (Trhoň a Maršík, 2008). 

Mimo to vyvstaly další otázky týkající se formátu a souřadnicového systému dat, 

jak data zobrazovat, aby byla zachována rychlá odezva při překreslení mapy a jaký 

stanovit datový model jednak pro zobrazení, jednak pro vyhledávání.  

Při řešení těchto a dalších otázek došli členové Komise GIS k závěru, že velmi 

důležitým krokem k vytvoření informačního systému je potřeba zabezpečit správu dat. 

Proto v období let 2004 – 2005 došlo ke zřízení a budování Centrálního datového skladu 

(CDS) v Institutu ochrany obyvatelstva (IOO) Lázně Bohdaneč (Leitgebová a Červenka, 

2014a). 

3.4.2 Funkce CDS 

CDS byl vytvořen, aby plnil tyto základní funkce: 

 vstupního hrdla pro data do informačních systémů organizace, 

 bezpečného uložiště dat, 

 správce licenční politiky při poskytování dat, 

 distribučního centra pro jednotlivé uživatele, 

 tvůrce a udržovatele jednotného datového modelu (Leitgebová a Červenka, 

2014a), 

 distributora a udržovatele aktuálních dat pro vyhledávání na serverech HZS 

krajů, 

 nepřetržitého prostředníka mezi koncovými uživateli a poskytovateli dat 

(Data a Centrální datový sklad HZS ČR, 2012). 

V posledním bodě je zmíněna komunikace s poskytovateli dat. Tato činnost je 

velmi zásadní vzhledem ke změnám jednotlivých datových sad a jejich atributů 

(Leitgebová a Červenka, 2014b). 

CDS obhospodařuje lokálně umístěná i on-line přicházející data, mezi které patří 

data od Vodafone CZ, data týkající se pořádaných dětských táborů, železničních 

přejezdů nebo meteorologické situace. Nad těmito daty je provedeno několik 

automatických úprav a poté jsou přehrávána na jednotlivé servery Krajských ředitelství 

HZS do vyhledávacích databází (Data a Centrální datový sklad HZS ČR, 2012). 
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3.5 Data u HZS 

U HZS ČR je využíváno velké množství dat, od různých poskytovatelů (Data 

využitá u HZS ČR, 2012). Data jsou neustále připravena pro využití na pracovištích 

HZS. Slouží nejen k podpůrným, rozhodovacím ale i k analytickým činnostem, které 

provádí koncový uživatel (Leitgebová a Červenka, 2014b). 

3.5.1 Dodavatelé dat 

Ve 2. díle ze série článků o Centrálním datovém skladu HZS ČR, který byl 

věnován datovým sadám, byla zveřejněna tabulka s hlavními dodavateli dat. Podle 

tabulky disponuje CDS daty od 23 zásadních poskytovatelů a to jak ze státní sféry, tak 

i z komerčního sektoru (Leitgebová a Červenka, 2014b). 

 

Tab. 3 Poskytovatelé dat pro HZS ČR 

Poskytovatel dat Počet 

vrstev 

Počet vrstev využitých 

ve vizualizačním 

projektu 

Armáda ČR (AČR) 70   

Central european data agency (CEDA) 16   

Česká energetická přenosová soustava (ČEPS) 5   

Česká pošta 2 2 

České dráhy (ČD) 4 2 

Český statistický úřad (ČSÚ) 40 3 

Český úřad zeměměřičský a katastrální (ČÚZK) 140 97 

Eltodo-Citelum 1   

Jaderná elektrárna Dukovany (JEDU) 10   

Jaderná elektrárna Temelín (JETE) 17   

Mapy.cz 4   

Ministerstvo školství 1 1 

Ministerstvo zdravotnictví 1 1 

Policie ČR (PČR) 15   

RWE Transgas (RWE) 15   

Ředitelství silnic a dálnic (ŘSD) 14 1 

Řízení letového provozu 5   

Správa chráněných oblastí 5   

Správa železniční dopravní cesty (SŽDC) 3 1 

Telekomunikační společnosti 12   

Úřad pro hospodářskou úpravu lesů (ÚHÚL) 70   

Výzkumný ústav vodohospodářský (VÚV TGM) 51 5 

Zdravotnická záchranná služba (ZZS) 1   

Celkem 502 113 
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Jedním z hlavních poskytovatelů je především Český úřad zeměměřický 

a katastrální, který poskytuje pro HZS data jako: 

 ZABAGED®,  

 Ortofoto České republiky,  

 GEONAMES (Leitgebová a Červenka, 2014b). 

 

Jiný přehled dodavatelů dat pro HZS ČR je uveden v dokumentu, který je 

zveřejněn na webových stránkách GIS PORTÁL HZS ČR (viz Příloha 4). Jsou zde 

zmíněni další poskytovatelé, jako je např. Čerpo, a.s., SHOCart, Skupina ČEZ a mimo 

jiné i konkrétní telekomunikační společnosti, které spolupracují s CDS (Telefónica O2 

a Vodafone CZ). 

Data jsou sbírána i na regionální úrovni, protože každý kraj České republiky má 

své jedinečnosti (GIS HZS ČR, 2012). Jednotlivé krajské pracoviště HZS spolupracují 

s desítkami lokálních poskytovatelů dat, jako jsou krajské úřady, magistráty, krajské 

hygienické stanice nebo správce sítí (Leitgebová a Petr, 2014b). Takto vzniklá specifická 

data jsou nezbytná pro činnost HZS krajů (GIS HZS ČR, 2012). 

Další desítky dat jsou vytvořeny samotnými krajskými HZS. Především to jsou 

vrstvy se sirénami, nebezpečnými objekty, jednotkami požární ochrany (JPO) nebo 

evakuačními místy (Leitgebová a Petr, 2014b).  

3.5.2 Specifická data 

Některá data byla vytvořena především pro účel snadnější lokalizace volajícího 

na operačním středisku nebo pro podporu vedení zásahu. Do těchto dat se řadí 

evidence stožárů vysokého napětí, traumabody, očíslování železničních přejezdů nebo 

vedení informací o skalních oblastech. Dalšími specifickými daty, která se mohou 

v mapách vyskytnout např. kilometráže vodních toků, silnic, železnic, rozčlenění silnic 

dle kategorií, vizualizace zástavby podle využití, názvy sídlišť, obchodních center atd. 

 

Stožáry veřejného osvětlení 

V mnoha městech mají správci zavedenou evidenci veřejného osvětlení (VO) 

v GIS. Každé zařízení má své jedinečné číslo a souřadnice X a Y. Tento jedinečný 

identifikátor (číslo) je čitelně umístěn na stožáru VO. Pro HZS ČR je tato skutečnost 

zásadní při lokalizaci místa události. Prvotní návrh zavedení číslování byl z důvodu 

usnadnění orientace v lokalitách, ve kterých je přesná lokalizace velmi obtížná. Jedná 

se především o dlouhé ulice nebo rychlostní komunikace v obcích. Účastník mimořádné 

události nahlásí číslo nejbližšího stožáru VO a operační středisko ho díky tomu dokáže 

přesně lokalizovat. V současné době HZS ČR disponuje databází stožárů VO 

od společnosti Eltodo-Citelum, s. r. o. pro celou Českou republiku. Tato společnost je 

předním správcem veřejného osvětlení (Komise GIS HZS ČR, 2012). 

 

 Traumabody 

Jedná se o místo v terénu, které je označeno tabulkou s jednoznačným kódem 

a kontaktem na tísňové linky nebo horskou službu. Tabulky jsou umísťovány zejména 

v oblastech s vysokou turistickou návštěvností. V současné době jsou traumabody 

rozmístěny např. v Krkonoších, na Šumavě, v Krušných horách, Českosaském 

Švýcarsku nebo v Chřibech (Traumabody, 2012). Data o traumabodech s příslušnými 

souřadnicemi jsou k dispozici jednotlivým operačním střediskům a na TCTV 112. 
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Traumabody byly během roku 2014 rozmístěny i v lokalitě Chřiby ve Zlínském 

kraji. Na operačním středisku s nimi pracují ve srovnání s jinými daty krátkou dobu. 

Do reálného provozu byly zavedeny během září. Do GIS aplikace se zadá číslo 

příslušného traumabodu a následně se v mapě zobrazí místo události. Celkem je 

v terénu 147 traumabodů.  

 

Číslování železničních přejezdů 

Tento systém umožňuje jednotnou, jednoduchou a jednoznačnou identifikaci 

železničních přejezdů. Identifikační údaje o přejezdu jsou poskytovány jako aktualizace 

1x týdně CDS a následně jsou distribuovány základním složkám integrovaného 

záchranného systému. Tyto údaje mají zároveň i zaměstnanci příslušného provozovatele 

dráhy. Aktivní nasazení a využívání číslování v rámci celé ČR bylo zahájeno 1. 8. 2009. 

Každý železniční přejezd na celostátních i na regionálních drahách má přidělené 

unikátní číslo: 

 přejezdy na dráhách ve vlastnictví státu: číslo ve tvaru P1 – P9000, 

 přejezdy na dráhách nevlastněných státem: číslo ve tvaru P9001 – P9999, 

 přejezdy na vlečce jsou označeny ve tvaru P10001 – P99999. 

Ke každému přejezdu jsou přiřazeny identifikační údaje s kontakty 

na příslušného dispečera a výpravčího. Samolepky jsou nalepené na vnitřní straně 

zařízení přejezdů a jsou reflexní (Číslování železničních přejezdů, 2012). 

  

Skalní oblasti 

V roce 2011 vznikl u HZS Libereckého kraje pilotní projekt „IZS ve skalních 

oblastech ČR“, který se zabývá mapováním skal a skalních oblastí, na kterých je 

provozována horolezecká činnost. Data pomáhají rychleji reagovat na nehody ve špatně 

přístupném terénu (Skalní oblasti, 2012). 

V celé republice je provozována horolezecká činnost na více než 11 300 skalách, 

přičemž je doposud zmapováno 10,51 % skal. Kompletně jsou zmapovány Jizerské hory 

a Hruboskalsko v Českém ráji (Leitgebová a Červenka, 2014b). 

  

Veterinární opatření 

Sběr dat pro zpracování veterinárních opatření spočívá v lokalizaci chovu 

hospodářských zvířat. Zájmovým faktorem je i stanovení druhu a maximálního počtu 

chovaných zvířat. Po vytvoření bodové vrstvy chovů jsou podle druhu hospodářských 

zvířat v dané lokalitě stanovena ochranná a pozorovací pásma. Tímto způsobem lze pak 

stanovit, jaká veterinární opatření se vztahují na obyvatele objektů, které spadají 

do stanovených pásem (Veterinární opatření, 2012). 

 

Dětské tábory  

„Systém geografických informačních systémů také využívá aktuální informace 

o dětských táborech, které se často nachází v lesích, u řek a v horách.“ (Svitáková 2012) 

V praxi v případě hrozícího nebezpečí povodní nebo silného větru, vyjíždí na místo 

rekreačního pobytu dětí hasiči, aby tábor evakuovali nebo provedli nezbytná opatření. 

„Systém poskytne okamžitě informace o místě, kde se tábor nachází, kolik je tam dětí 

a vedoucích, kontakty i dobu pobytu.“ (Svitáková, 2012)  
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3.5.3  Nejednotnost dat 

Data, která se dostávají na pracoviště CDS HZS, nejsou jednotného typu. Liší se 

např. různými formáty nebo souřadnicovým systémem pro jejich prostorové zobrazení. 

Několik typů formátů, ve kterých jsou poskytována data do CDS: 

 shp (shapefile), 

 gdb (File Geodatabase), 

 DGN, 

 xls (tabulka Excel), 

 xml (výstupy z databází, registry). 

Nejčastěji používané souřadnicové systémy: 

 S-JTSK Křovák East North, 

 WGS-84, 

 ETRS 89. 

Geodata si kromě geometrické části (bod, linie nebo polygony) nesou rozsáhlé 

informace v atributech (Červenka, 2014).  

3.5.4 Operace s daty od převzetí po jejich distribuci 

Základní otázkou při budování a rozvoji CDS bylo, jak dosáhnout jednotnosti dat 

a kontinuity během distribuce do jednotlivých systémů HZS ČR a dalších pracovišť IZS. 

Proto byl přesně stanoven datový model, který definuje požadavky na shodný formát dat 

a souřadnicový systém. Mimo to pevně stanovuje jejich atributovou podobu. Atributová 

část je důležitá při vyhledávání v databázi, proto data vyžadují při zpracování velkou 

pozornost. Dochází k různým přiřazením a dopočítání vazebných položek s cílem 

maximálního využití těchto dat.  

 Z tohoto důvodu je nad daty prováděno několik operací. Jedná se o několik 

kroků, které probíhají v datovém skladu při každé aktualizaci stávajících datových sad 

nebo obdržení nových dat. Tyto kroky můžeme rozdělit na 3 části. 

1. krok 

Obdržená data od poskytovatelů jsou umístěna do úložiště. Zde jsou spuštěny 

aktualizační skripty. Ty jsou součástí ETL procesů (Extract, Transform, Load). Jak již 

napovídá zkratka, data jsou rozbalena, transformována a uložena do databáze, která je 

označena názvem „pracovní prostor“. 

2. krok 

Na počátku této fáze dochází k prvotním kontrolám. Data jsou následně 

upravována podle přesně stanoveného datového modelu. V závěru této části zpracování 

dochází k výstupní kontrole, která je schopná odhalit případné nově vzniklé chyby 

během zpracování dat. 

3. krok 

Ve třetí fázi se data přesunují do další databáze, která je označována jako 

„datový sklad“ pomocí tzv. „datové pumpy“. Nachází se zde již zpracovaná data, která 

jsou vyčištěná, v přesně odpovídajících datových modelech. Takto upravená a uložená 

data jsou připravena pro distribuci do jednotlivých HZS ČR. Data jsou na pracoviště 

dodávána v periodicky se opakujících aktualizacích. Dále jsou využívána k publikování 

ve formě webové služby.  
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V rámci CDS HZS je jako úložiště využívaná databáze Oracle a databázový 

formát gdb (File Geodatabase) od společnosti ESRI. 

Cílem pracoviště CDS je podporovat GIS v rámci HZS ČR a IZS. Geografická data 

jsou proto poskytována vždy aktuální, kompletní, bezchybná a v rozsahu datových 

modelů, které jsou stanoveny koncovými uživateli. Takto upravená data slouží nejen 

k tvorbě mapového projektu, tzn. k vizualizaci dat, ale i k vyhledávání v databázích 

(Červenka, 2014). 

Harmonizací dat pro krizový management se věnuje Šťastný (2008). Zabývá se 

harmonizací dat, které jsou v různých souřadnicových systémech, v různých datových 

formátech, v různých měřítcích, v různých jazycích a harmonizací dat vytvořených 

různými postupy. 

3.6 GIS aplikace u HZS ČR 

V současné době Hasičské záchranné sbory disponují různými GIS aplikacemi, 

a to jak desktopovými, tak i webovými nebo flexovými.  

3.6.1 Desktopové aplikace 

Mezi nejčastěji používané desktopové GIS aplikace patří: 

 ArcGIS for Desktop (v rozsahu licencí View, Editor, Info), 

 ArcSDE, 

 ArcGIS for Server (ve verzích Standard a Enterprise). 

Tyto desktopové aplikace využívají především správci GIS HZS krajů a CDS IOO 

Lázně Bohdaneč. S jejich pomocí spravují data a využívají je k tvorbě mapových 

projektů a tištěných výstupů. Na krajských operačních střediscích HZS ČR se častěji 

používá GIS aplikace GiSelIZS AE (GIS HZS ČR, 2012). 

 

ArcGIS 

Americké společnost ESRI je v současné době předním producentem GIS 

aplikací na světovém trhu. Produkty od této firmy nejsou v oblasti krizového 

managementu v ČR používány pouze u Hasičských záchranných sborů, 

ale i na krajských úřadech nebo na některých ministerstvech (Konečný et. al, 2011). 

Nejnovější verzí, která je na trhu, je verze 10.2.2. U HZS se ovšem setkáváme 

i se staršími verzemi, jako je např. verze 9.2, 10.0 nebo verze 10.1. 

ArcGIS for Desktop je označení desktopové aplikace, která se skládá ze dvou 

částí, a to ArcMap a ArcCatalog. K dispozici je ve třech licencích - Basic, Standart 

a nejvyšší Advanced. V předchozích verzích nesli tyto licence označení ArcView, 

ArcEditor a nejvyšší ArcInfo (Balun, 2013). 

  

GISelIZS AE 

„GISelIZS AE je desktopovou GIS aplikací, vytvořenou firmou T-Mapy 

spol. s r. o., určenou pro operační střediska jednotlivých složek. Jejím účelem je 

podpora co nejrychlejší lokalizace místa nahlášené události, tedy vyhledání lokality 

a její zobrazení v mapě.“ (GISel IZS, 2012) 

Aplikace má několik částí, ze kterých je složena. Jedná se o IZS Administrátor, 

IZS Operátor a IZS Search Admin. IZS Administrátor je extenze do ArcGIS Desktop 

pro přípravu mapových projektů správcem GIS. IZS Operátor slouží jako GIS klient 
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pro vizualizaci mapových podkladů na operačním středisku. IZS Search Admin je 

nástroj pro přípravu uživatelsky definované vyhledávací databáze. 

Pracovníci GIS HZS krajů se věnují přípravě a implementaci datových podkladů 

z centrálního datového skladu, obnáší to nejen přípravy, ale i sběr lokálních 

tematických dat z území vlastního kraje. „A to včetně tvorby mapových projektů pro GIS 

aplikaci a její konfigurace pro vazbu na výjezdovou aplikaci Spojař. Vizualizace 

podkladové mapy je ve všech krajích stejná, jelikož se využívají mapové dlaždice.“ (GISel 

IZS, 2012) 

První verze této aplikace nesla označení GISelIZS a měla omezenější funkce 

a možnosti vyhledávání než současná verze GISelIZS AE. Důvodem rychlejšího 

a objemnějšího vyhledávání je přechod vyhledávacích databází do relační databáze 

(GISel IZS, 2012). 

Podobnou problematikou se zabývá Ferková a Maršík (2009), kteří popisují 

využití aplikace GISelIZS AE v operačnním řízení HZS. Zabývají se nejen seznámením 

s novou verzí této aplikace a jejím uplatněním v GIS HZS, ale i samotnou architekturou 

GIS ISKŘ.  

3.6.2 Webové aplikace 

S webovými aplikacemi se na HZS ČR aktivně pracuje od roku 2009. Jednou 

z hlavních výhod webového řešení je snížení nákladů na licence koncových uživatelů. 

Právě toto bylo hlavní snahou odborníků HZS ČR. „Zpřístupnili široké spektrum GIS 

funkcí co možná největšímu počtu uživatelů, a to nejen svým kolegům, ale také 

pracovníkům ostatních složek a organizací, kteří nemají možnost využívat „těžkého“ GIS 

klienta (sofistikovaný SW nainstalovaný na PC).“ (Leitgebová a Červenka, 2014c) 

Webové řešení dále umožňuje centralizovanou správu dat, má možnost sdílet 

tyto data s dalšími složkami IZS, veřejné správy nebo samosprávy. Mimo to je zde 

možné vizualizovat dynamická data týkající se mimořádných událostí, polohu 

výjezdových vozidel a mnoho dalšího (Brothánek, Špulák a Parkman, 2014).  

3.6.3 Tenký mapový klient 

Hlavní myšlenka pro vznik Tenkého mapového klienta vznikla v roce 

2009/ 2010. Ve spolupráci s firmou ARCDATA Praha, s. r. o. vznikla první verze 

„tenkého“ webového mapového klienta, který byl využitelný pro všechny uživatele 

s očítačem připojeným k internetu/intranetu a vybaveným běžným webovým 

prohlížečem. „Tato aplikace byla kontinuálně vyvíjena a zdokonalována GIS specialisty 

HZS ČR s využitím neustále se vyvíjejícího uživatelského prostředí.“ (Leitgebová 

a Červenka, 2014c) Byla využita data distribuovaná centrálním datovým skladem. 

Vzhledem k zastaralosti původní aplikace bylo nutné ji nahradit novou verzí (Leitgebová 

a Červenka, 2014c). 

V roce 2014 byly spuštěny nové verze mapových klientů. První je verze pro stolní 

počítače nebo notebooky, tzv. desktopová verze. Druhá verze je určena pro mobilní 

zařízení (Brothánek, Špulák a Parkman, 2014).  

„Předpoklady pro spuštění desktopové verze Tenkého mapového klienta HZS ČR 

je internetový prohlížeč a nainstalovaný Adobe Flash plugin.“ (Byly nasazeny nové verze 

mapových klientů, 2014) Dalším požadavkem je operační systém WINDOWS, Linux 

nebo MAC OS X. Připojení může být internetové nebo v rámci intranetu (Brothánek, 

Špulák a Parkman, 2014). „V intranetové síti je navíc tato aplikace rozšířena o sběr 
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tematických dat nebo možnost sledovat vozidla či probíhající zásah.“ (Leitgebová a Petr, 

2014a)  

Problematikou Smart klienta pro krizové řízení se zabývá Nétek (2014). Jedná se 

o rozšíření funkcionality tenkého klienta, kdy klient ve formě webového prohlížeče 

disponuje rozšířenou funkcionalitou. Tento přístup využívá kombinace Rich Internet 

Application (RIA) a servisně orientované architektury (SOA). Zásadním přínosem je 

možnost "on-screen" editace prostorových i atributových dat v reálném čase skrz 

prostředí webového prohlížeče. To je založeno na využití webových služeb, konkrétně 

Transactional Web Feature Service (WFS-T).“ 

3.6.4 Mobilní mapový klient 

„Aplikace byla vyvinuta pomocí JAVA Script a HTML 5.“ Využívá služby ArcGIS 

Serveru 10.2.1. Systémové požadavky na mobilní verzi jsou: 

 smartphone / tablet s OS Android, iOS, Windows Mobile, 

 internetový prohlížeč (Brothánek, Špulák a Parkman, 2014). 

„Předpoklady pro spuštění mobilní verze Tenkého mapového klienta HZS ČR je 

internetový prohlížeč a podpora JAVY.“ (Byly nasazeny nové verze mapových klientů, 

2014) 

3.7 Vizualizace dat 

„Mapy HZS ČR vznikají kombinací mnoha různorodých zdrojů dat, doplněných 

o specifická data HZS ČR.“ (Leitgebová a Červenka, 2014a) Pracovníci GIS HZS vytvářejí 

specifické mapy nejen pro hasiče, ale i pro ostatní složky integrovaného záchranného 

sboru. Na operačních střediscích mají velmi podrobné mapy, až do čísla popisného 

a využívají i mapy katastru nemovitostí. Tato skutečnost napomáhá rychlému zásahu 

hasičů (Štrauchová, 2012). 

Specifická mapa je i základní podkladová mapa pro Tenkého mapového klienta 

a to zejména svojí strukturou.  

3.7.1 Mapový projekt podkladové mapy 

Podkladová mapa v aplikaci Tenkého mapového klienta HZS vychází 

z geografické báze dat ČÚZK ZABAGED®. Je vizualizovaná pomocí mapového projektu, 

který je dílem specialistů HZS ČR z řad Komise GIS. Pro svou podobu a náplň je 

unikátní. „V této mapě je kladen důraz na důležité orientační prvky, jako jsou 

např. čísla silnic a železnic, kilometráž silnic, železnic a vodních toků, čerpací stanice, 

telekomunikační vysílače, stavební objekty s čísly domovními/orientačními 

a v neposlední řadě specifická data HZS ČR.“ (Leitgebová a Červenka, 2014c) 

„Na samotném operačním středisku se k této podkladové mapě připojuje ještě mnoho 

tematických krajských dat.“ (Leitgebová a Petr, 2014a)  

3.7.2 Vývoj mapového projektu 

Vývoj mapového projektu byl úzce spjat s vývojem GIS u HZS ČR. Původní 

projekt obsahoval několik málo vrstev. Postupem času začal narůstat objem dat 

a vznikala mapa, ze které bylo možné získat velké množství podrobných informací. 

„Projekt byl založen čistě na vektorových vrstvách, což znamenalo problém s pomalejším 

vykreslováním mapy.“ (Leitgebová, 2014) 
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V roce 2009 se vektorová mapa nahradila mapou složenou z dlaždic. Hlavní 

výhodou dlaždic je rastrové provedení. Vykreslení je tak mnohonásobně rychlejší 

než u předchozí vektorové varianty mapového projektu. Mapové dlaždice byly postupně 

zdokonalovány během následujících dvou let. Prioritou vývoje bylo vytvoření mapy 

s maximálním množstvím informací při zachování co nejlepší čitelnosti dat (Leitgebová, 

2014). 

Mapové dlaždice jsou poskytovány jako služba mapového serveru, který je 

součástí centrálního datového skladu v IOO Lázně Bohdaneč (Leitgebová a Červenka, 

2014c). Dlaždice jsou optimalizované ve velikosti 256×256 px ve formátu JPEG. Celý 

projekt je pravidelně aktualizován jednou ročně (Leitgebová a Petr, 2014b).  

3.7.3 Měřítkové řady mapového projektu 

„Mapový projekt je vytvořen v deseti měřítkových řadách, které na sebe logicky 

navazují.“ (Leitgebová, 2014) Nejmenší měřítko je 1 : 2 000 000, které slouží pro rychlou 

orientaci nad územím celé České republiky. Největší měřítko 1 : 2 000 je u mapy, která 

je nejpodrobnější. V této mapě je použito 109 vrstev, je zde popsáno 91 témat a použito 

přes 150 druhů mapových značek (Leitgebová, 2014). 

Velkou výhodou je i návaznost symbologie mezi mapami jednotlivých měřítek 

(Leitgebová a Petr, 2014b).  

3.7.4 Hlavní důvody vzniku specifických map u HZS ČR 

Jedním z předních důvodů je možnost interpretace a propojitelnosti. HZS ČR má 

přístup k obrovskému množství různorodých dat. Tato data je nezbytné zpracovat. Tím 

jsou získávány informace, které je potřeba vhodně interpretovat a mezi sebou propojit. 

Důležitá je i rychlá reakce na změny nejen v datovém modelu dodávaných dat, 

zjištění chyb, ale i reakce na požadavek změny vizualizace dat v mapovém podkladu. 

Vše s ohledem na minimální náklady. 

Dochází také k maximálnímu možnému využití dat a vytěžení informací. 

Takovou mapu, která bude obsahovat největší možné množství informací, a přesto bude 

přehledná, potřebuje zejména operační středisko. „Pro zjednodušení práce operačního 

střediska je součástí mapového projektu i rozsáhlá legenda, kterou mají pracovníci 

k dispozici.“ (Leitgebová, 2014)  

Jedním z posledních důvodů je i ekonomická stránka. Komerční zpracování 

při každé aktualizaci dat a jakékoliv jiné změně by vedly k mnohamilionové zátěži 

a zpomalení celého systému HZS ČR (Leitgebová, 2014).  

3.8 Řešená problematika v rámci diplomových 

a bakalářských prací 

Na téma GIS a HZS ČR bylo napsáno již mnoho diplomových a bakalářských 

prací. Některé se tohoto tématu týkaly více, jiné pouze okrajově. 

Například Jiříček (2011) se zabývá porovnáním navigačních systémů, které 

používají jednotlivé krajské Hasičské záchranné sbory. Zjišťuje, na jaké úrovni jsou 

technologie sloužící k nejrychlejší a nejpřesnější lokalizaci místa mimořádné události. 

Popisuje geografické informační systémy u Hasičského záchranného sboru České 

republiky a funkci těchto systémů při lokalizaci volajícího na tísňovou linku nebo 

výjezdových vozidel. Okrajově se věnuje i tématice GIS u HZS. 
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Geografickými informačními systémy se zabývá i Kluzová (2013). Podrobněji 

rozepisuje vybrané poskytovatele dat pro CDS IOO Lázně Bohdaneč a aplikace, které 

využívají HZS v praxi. 

Řežábek (2011) se okrajově zabývá GIS u HZS ČR. Rozebírá softwarové řešení 

u HZS ČR. Vysvětluje zde například provázanost a funkčnost správcovské části ArcGIS 

s IZS operátorem. Zmiňuje se i o datech a Komisi GIS HZS ČR. Dále se věnuje 

mapovému projektu GIS HZS ČR, propojení výjezdové aplikace Spojař a GIS a souborem 

typových úloh, které jsou řešeny v praxi. 

Desktopovými nástroji se okrajově zabývá Balun (2013). Orientuje se především 

na využití GIS nástrojů při řešení evakuace při zatopení objektů v krizových situacích. 

Dále se geografickými informačními systémy u HZS zabývá Pomahačová (2010).  

Koutný (2013) se zabývá problematikou prostorových i neprostorových analýz. 

Analýzy jsou prováděny nad výjezdovými daty Hasičského záchranného sboru 

v Olomouci. 
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4 DOTAZNÍKOVÉ ŠETŘENÍ  

V rámci teoretické části bylo cílem zjistit současný stav využívání GIS u HZS 

v České republice. Na každé krajské pracoviště HZS byl zaslán dotazník v elektronické 

podobě (náhled viz Příloha 5). Dotazník byl sestaven pomocí formuláře Google a skládal 

se celkem ze čtyř tematických okruhů. 

První část byla zaměřena na desktopové aplikace. V rámci této části byly 

položeny otázky týkající se zjištění počtu GIS softwarů, které využívají a o jaké softwary 

se jedná. Druhá část se týkala využívání webových aplikací. Bylo zjišťováno, jaké 

webové aplikace využívají, jejich počet, zda jsou veřejné nebo neveřejné a pokud se 

jedná o veřejné, které to jsou. Třetí část byla zaměřena na samotné využívání GIS 

na jejich pracovišti. Otázky se týkaly počtu zaměstnanců, kteří s GIS pracují, 

od kterého roku GIS využívají a zda provádějí periodické analýzy nad daty. Poslední část 

se týkala dat, která jsou jim poskytována z IOO Lázně Bohdaneč. Otázky byly zaměřeny 

na datové sady, které nejčastěji využívají a jak často bývají data aktualizována. 

4.1 Výsledky dotazníkového šetření 

Na dotazník odpovědělo všech 14 krajských pracovišť HZS. Výsledky jsou 

tematicky rozděleny do podkapitol odpovídající okruhům v dotazníku. Přehledové 

tabulky obsahují otázky a odpovědi ke každému kraji. Tabulky jsou doplněny 

o  komentář s postřehy.  

4.1.1 Desktopové aplikace 

Z dotazníků je patrná značná nejednotnost verzí ArcGIS, které využívají (9.2 - 

10.2.2., Basic, Advance, …). Mimo to jsou často využívány obě verze aplikace GISelIZS 

(novější GISelIZS AE) a v některých případech je zmíněna i aplikace IzsOperátor.  

Počet softwarů se liší. Moravskoslezský kraj připojil poznámku, že se jedná o pět 

dostupných licencí, které využívají na 7 pracovištích. Počet softwarů u Ústeckého kraje 

byl uveden bez jakékoliv poznámky. Informace nebyla dále zkoumána. 

 

Tab. 4 Výsledky dotazníkového šetření v rámci jeho první části. 

Kraj 

Kolik 

desktopových 

GIS softwarů 

používáte? 

O jaké softwary se jedná? 

 

Hl. město Praha 1 
ArcGIS for Desktop Standard concurrent use, 

ESRI 

Jihočeský 1 Arcgis Desktop 10.0 

Jihomoravský 2 ArcGis Desktop 10.1, IzsOperátor (firma T-mapy) 

Karlovarský 3 

ArcGIS 10.2.2. for Desktop Advanced concurrent 

use, 

ArcGIS 10.2.2. for Desktop Standard single use, 

GISelIZS AE 1.0.3.1610 

Královehradecký 2 ArcGIS, GiselIZS AE 
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Kraj 

Kolik 

desktopových 

GIS softwarů 

používáte? 

O jaké softwary se jedná? 

 

Liberecký 3 
ArcGIS for desktop basic,  

ArcGIS for Desktop Standard  

Moravskoslezský 5 

ESRI 

2x Arcgis for Desktop Advance, 

3x Arcgis for Desktop Basic, 

A pak dvě license Serverů 

Olomoucký 1 ArcGIS Server Enterprise, ArcGIS Info 

Pardubický 3 

ArcGIS desktop - verze 9.2 a 10.0, extenze 

Publisher, 

Gisel IZS, Gisel IZS AE 

Plzeňský 1 ArcGIS Pro, ESRI Inc. 

Středočeský 2 

ArcGIS 10.1 for Desktop, Advanced, concurrent 

use, ESRI (ArcInfo), 

ArcGIS 10.1 for Desktop, Basic, single use, ESRI 

(ArcView) 

Ústecký 18 
ArcView ESRI, ArcEditor ESRI, IzsOperator  

T-Mapy, Map (TCTV 112) Vítkovice IT Solutions 

Vysočina 4 ArcView, ArcEditor, ArcGIS Server, GISelIZS AE 

Zlínský 2 ArcGIS for desktop - verze Basic, GiselIZS 10.0 

4.1.2 Webové aplikace 

Na otázku zda využívají webové aplikace, odpovědělo 11 krajů kladně. V polovině 

případů využívají i veřejně dostupné aplikace (např. gis.izscr.cz).  

 

Tab. 5 Výsledky dotazníkového šetření v rámci jeho druhé části. 

Kraj 

Používáte 

webové 

aplikace? 

Pokud ano, 

uveďte počet 

využívaných 

aplikací. 

Jsou veřejně 

dostupné nebo 

určené pouze pro 

Vaši potřebu? 

O jaké veřejně 

dostupné 

aplikace se 

jedná? 

Hl. město Praha Ano 6 
Veřejně dostupné, 

Neveřejné 

mapy.cz, 

maps.google.com, 

Google Earth, 

www.bing.com/ma

ps, gis.izscr.cz 

Jihočeský Ano 1 Neveřejné  

Jihomoravský Ano 1 Neveřejné  

Karlovarský Ne    

Královehradecký Ne    
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Kraj 

Používáte 

webové 

aplikace? 

Pokud ano, 

uveďte počet 

využívaných 

aplikací. 

Jsou veřejně 

dostupné nebo 

určené pouze pro 

Vaši potřebu? 

O jaké veřejně 

dostupné 

aplikace se 

jedná? 

Liberecký Ano 

Opravdu 

netuším, kolik 

pracovníků na 

webové služby 

přistupuje a 

skutečně je 

dále využívá 

Veřejně dostupné, 

Neveřejné 
gis.izscr.cz  

Moravskoslezský Ano 

3 publikované 

webové 

aplikace 

Veřejně dostupné, 

Neveřejné 

dppmsk.hzsmsk.cz 

Jedná se o 

povodňové plány, 

které jsou 

provozovány na 

prostředcích 

HZSMSK. 

Další aplikace je 

pro potřeby 

krizových plánů, 

ale ta je neveřejná. 

Olomoucký Ano 1 Neveřejné  

Pardubický Ano 2 
Veřejně dostupné, 

Neveřejné 

Flex klient puštěný 

do internetu a 

intranetu 

Plzeňský Ne    

Středočeský Ano 5 Neveřejné  

Ústecký Ano 4 
Veřejně dostupné, 

Neveřejné 

http://www.hzsou

l.cz/paleni2/?men

u=3 

Složitější aplikace 

pouze interně. 

Vysočina Ano 2 Neveřejné  

Zlínský Ano 2 
Veřejně dostupné, 

Neveřejné 
gis.izscr.cz 

 

4.1.3 GIS na pracovištích HZS 

V rámci této části bylo zjištěno, že otázka týkající se zaměstnanců pracujících 

s GIS nebyla dostatečně specifikována. Došlo ke sloučení pracovníků, kteří GIS spravují 

a pracovníků operačního střediska, kteří využívají GIS spojené s dalšími nadstavbovými 

aplikacemi.  

 Dále lze vyvodit, že nasazování GIS na pracovištích probíhalo v průběhu let 2001 

až 2006 (mimo Moravskoslezský kraj). 
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Tab. 6 Výsledky dotazníkového šetření v rámci jeho třetí části – první skupina otázek. 

Kraj 

Od kterého roku 

využíváte GIS na 

Vašem pracovišti 

HZS? 

Kolik zaměstnanců u Vás pracuje s GIS? 

Hl. město Praha 2005 1 

Jihočeský 2004 1 

Jihomoravský 2006 cca 30 

Karlovarský 2002 3 

Královehradecký 2002 1 

Liberecký 2001/2006 2 

Moravskoslezský cca 1994 

Všichni jsou konzumenti nějakého GISu. Na 

přípravě dat a mapových výstupů pracuje cca 7 

lidí 

Olomoucký 2003 300 

Pardubický 2002 7 

Plzeňský 2004 1 

Středočeský 2004 1 

Ústecký Netuším 50+ 

Vysočina 2004 

1x GIS správce, který se stará o veškeré 

databáze, projekty, složitější analýzy 

1x pracovník ochrany obyvatelstva, který pro 

havar.plán kraje dělá různé výstupy z dat a 

analýz 

6x operační důstojník, který má desktop GIS 

svázaný s výjezdovou aplikací pro řešení 

mimořádných událostí 

4x operátor TCTV112, který má GIS klienta 

svázaného s aplikací pro příjem tísňového volání 

pro vizualizaci místa mimořádné události 

běžní uživatelé, kteří s GIS pracují ve formě 

tenkého webového klienta 

Zlínský 2005 30 

 

Pouze polovina krajů provádí nad daty periodické analýzy. Většinou se jedná 

o síťové analýzy, analýzy rizik, 3D analýzy, atd.  

 

Tab. 7 Výsledky dotazníkového šetření v rámci jeho třetí části – druhá skupina otázek. 

Kraj 

Provádíte u Vás 

periodické analýzy a 

vizualizaci dat? 

O jaké analýzy se jedná a jak často jsou 

prováděny? 

Hl. město Praha Ne  

Jihočeský Ano Různé, pravidelně 



33 

Kraj 

Provádíte u Vás 

periodické analýzy a 

vizualizaci dat? 

O jaké analýzy se jedná a jak často jsou 

prováděny? 

Jihomoravský Ne  

Karlovarský Ano 

Statistické sledování událostí - 1x ročně, 

veterinární opatření - nepravidelně při 

aktualizaci dat o chovech, úniky 

nebezpečných látek + vnější havarijní plány - 

vždy při změně množství skladované 

nebezpečné látky 

Královehradecký Ne  

Liberecký Ano statistika, 3d analýzy, síťové analýzy 

Moravskoslezský Ano 

Síťové analýzy na desktopu cca 5x za rok 

A pak analýzy různého druhu a různé 

periodiky: 

analýza rizik (šíření nebezpečných látek, 

alokace sirén) 

analýza odtokových poměrů 

Olomoucký Ne  

Pardubický Ano 

počty osob na zasaženém území, tvorby 

buferů okolo zájmových objektů, analýzy 

rizik území - jsou prováděny průběžně po 

celý rok 

Plzeňský Ne  

Středočeský Ne  

Ústecký Ne  

Vysočina Ano 
buffery, vizualizace statistických údajů o 

zásahovosti na našem území 

Zlínský Ano 
některé jsou pravidelné, jiné dle potřeb a 

požadavků. 

 

 

4.1.4 Data 

Poskytovatelé datových sad a samotné datové sady se nikterak neliší 

od přehledu, který je uveden v kapitole týkající se dat použitých v HZS (viz Tab. 3 

a Příloha 4).  

Data bývají nejčastěji aktualizována každého půl roku. Z dotazníků je však 

patrné, že se tento interval liší s každou datovou sadou. Některá data vyžadují 

aktualizaci častěji, méně důležitá data jsou aktualizována řádově i v průběhu několika 

let. 
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Tab. 8 Výsledky dotazníkového šetření v rámci jeho čtvrté části. 

Kraj 
Jaké datové sady nejčastěji 

využíváte? 

Jak často jsou data 

aktualizována? 

Hl. město Praha ZABAGED®, RÚIAN Každého půl roku 

Jihočeský datový sklad IOOLB Jednou za 3 měsíce 

Jihomoravský 
ZABAGED®, CEDA, RÚIAN, 

ŘSD, ČD 
Každého půl roku 

Karlovarský 

ZABAGED®, VÚV, SŽDC, 

RÚIAN, ČSÚ, CEDA, ŘSD, 

ČEPS, ČEPRO, PČR, 

mapy.cz, ČÚZK, O2, 

VODAFONE, RWE, vlastní 

data 

Každého půl roku 

Poznámky: 

Některá méně důležitá data jsou 

aktualizována i v delším časovém 

období. 

Královehradecký RÚIAN, CEDA, ZABAGED® 

Poznámky: 

-aktualizace dat je různá pro různé 

datové sady. Největší část dat 

dostupná z našeho  

Centrálního datového skladu se 

aktualizuje cca jednou ročně. Ale 

máme i sady, které se aktualizují v 

řádu týdnů případně i dní. 

Liberecký http://gis.izscr.cz/wpgis/70/ 
záleží na datech, průběžně, 

půlročně, ročně  

Moravskoslezský 

ZABAGED®, CEDA 

RÚIAN 

ČSÚ 

VÚV 

ŘSD, … 

Ročně 

Poznámky: 

Průměrně ročně. 

Jinak místopis a podkladová mapa 

1x za půl roku. 

Ale jsou tam obsažena data, která 

se aktualizují i 1x za 2-3 roky. 

Olomoucký ZABAGED®, CEDA Každého půl roku 

Pardubický 
ZABAGED®, RÚIAN, ČSU - 

RSO, CEDA, Ortofoto ČUZK 
Každého půl roku 

Plzeňský ZABAGED®, CEDA Každého půl roku 

Středočeský 
data ČSU, RÚIAN, ŘSD a 

VÚV 
Každého půl roku 

Ústecký ZABAGED® 
rozdílové aktualizace každé sady i 

každý týden 

Vysočina 

ZABAGED®, StreetNet, 

RÚIAN, DIBAVOD, ŘSD, 

Turist.trasy Seznam.cz, OSM, 

.... 

Každého půl roku 

Zlínský 
v současnosti mapové cache 

vytvořené z více datových sad 

rozdílné u různých dat. sad., 

většinu 2x ročně 
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5 TVORBA TOOLBOXŮ 

Hlavním cílem vytvořením modelů v rámci bakalářské práce byla snaha o úsporu 

času pracovníků Hasičského záchranného sboru Zlínského kraje, který nad každoroční 

aktualizací podkladových materiálů stráví. Odhadem se bude jednat i o několik týdnů 

práce.  

5.1 Seznámení se s daty 

Před samotným sestavením toolboxů (sad nástrojů) bylo třeba se seznámit 

s daty, která byla poskytnuta Hasičským záchranným sborem Zlínského kraje.  

Výsledkem sestavovaných modelů jsou nejen grafické výstupy, ale především 

i 14 tabulek zásahových obvodů Zlínského kraje. Výsledné tabulky zásahových obvodů 

měly být naplněny různými informacemi, které byly uloženy celkem v 9 odlišných 

vrstvách. 

Seznámení se s daty vedlo k určení atributů z každé vrstvy, ze kterých budou 

zjišťovány potřebné dílčí informace. Většina atributů sloužila jako podklad pro výpočet 

konečných hodnot. 

5.1.1 Struktura výsledných tabulek 

Výsledné tabulky pro jednotlivé zásahové obvody obsahují vybrané informace 

týkající se obcí spadajících do vybraného obvodu. Celkem je takto rozděleno 307 obcí. 

Pomocí modelu budou tak zjišťovány nejen tyto obce, ale i požadované informace o nich: 

 ORP, do které spadá obec, 

 okres, do kterého spadá obec, 

 plocha obce, 

 zastavěná plocha budovami, 

 plocha lesů, 

 plocha záplavového území stoleté vody (Q100), 

 délka dálnic, rychlostních komunikací a silnic 1. – 3. třídy, 

 délka železnic,  

 počet JPO (Jednotek požární ochrany) II, 

 počet JPO III, 

 počet JPO IV, 

 počet JPO V, 

 počet JPO VI. 

 

Výsledná tabulka pro všechny zásahové obvody má z části odlišnou strukturu. 

V rámci této tabulky jsou vyplňovány informace k 13 zásahovým obvodům ve Zlínském 

kraji. Pomocí modelu budou zjišťovány následující informace: 

 název obvodu, 

 plocha obvodu, 

 počet obcí v obvodu, 

 zastavěná plocha budovami, 

 plocha lesů, 

 plocha záplavového území stoleté vody (Q100), 

 délka dálnic, rychlostních komunikací a silnic 1. – 3. třídy, 

 délka železnic,  
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 počet JPO (Jednotek požární ochrany) II, 

 počet JPO III, 

 počet JPO IV, 

 počet JPO V, 

 počet JPO VI. 

5.1.2 Použité atributy  

Pro tabulky jednotlivých zásahových obvodů byly využity vrstvy obsahující 

požadované informace. Z vrstvy obcí byly použity názvy obcí, které spadají do vybraného 

zásahového obvodu a atributy nesoucí rozlohu obce, ORP a okres. Z vrstvy budov, lesů 

a záplavového území byl použit atribut s rozlohou, z vrstvy dálnic a železnic atributy 

s délkou. Z vrstvy Jednotek požární ochrany byly zjišťovány informace o počtu 

vybraných kategorií JPO v každé obci. 

Pro tabulky všech zásahových obvodů byly využity i jiné vrstvy. Z vrstvy 

hasebních obvodů byly zjištěny názvy obvodů a jejich plocha, z vrstvy obcí byl zjištěn 

pouze počet obcí spadajících do zásahového obvodu.  

5.2  Struktura toolboxů 

Celkem byly vytvořeny dva typy toolboxů. Tyto toolboxy byly rozděleny 

dle výsledků a výstupů z dílčích modelů. První typ zajišťuje vytvoření konečných 

tabulek zásahových obvodů Zlínského kraje, druhý typ obsahuje nástroje pro vytvoření 

ořezů vybraných vrstev podle katastrálního území každé obce a skript pro jejich 

sloučení a vytvoření pdf. 

 

 

Obr. 2 Struktura vytvořených toolboxů. 
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5.2.1 Toolbox pro vytvoření tabulek 

Celý toolbox se jmenuje „Tvorba tabulek zásahových obvodů“. Jednotlivé 

nástroje jsou rozděleny do třech částí, tzv. toolsetů.  

První část obsahuje nástroje pro tvorbu tabulek pro jednotlivé zásahové obvody. 

Do této části jsou začleněny tři modely. První tvoří dílčí tabulky, druhý obsahuje třetí, 

vnořený, model a slučuje dílčí výstupy do výsledných tabulek. Modely jsou 

parametrické. 

Druhá část obsahuje nástroje pro tvorbu tabulek pro všechny zásahové obvody 

Zlínského kraje. Výsledná tabulka se obsahově liší. Jedná se o sumarizační tabulku, 

která obsahuje celkové součty daných informací k zásahovým obvodům. Z důvodu této 

odlišnosti byly sestaveny samostatné nástroje. Modely jsou opět parametrické. 

Poslední část byla vytvořena po vzájemné domluvě s Hasičským záchranným 

sborem Zlínského kraje, která má usnadnit práci při tvorbě jak dílčích, tak i konečných 

tabulek. Aby se zamezilo značné obsáhlosti modelu, který by byl náchylný k selhání, je 

rozdělen do čtyř částí (modelů), Ty vytvářejí všechny dílčí tabulky pro zásahové obvody. 

Tyto modely jsou doplněny o nástroj pro sloučení všech těchto dílčích tabulek do 13 

konečných a vnořený model. 

5.2.2 Toolbox pro vytvoření ořezů 

Tento toolbox se jmenuje „Tvorba ořezů vybraných vrstev a map“. Toolbox 

obsahuje dva modely a jeden skript.  

První model vytváří ořezy vybraných vrstev podle katastrálního území obcí 

pro verzi ArcGIS 10.0. Druhý model je obdobou pro verzi 10.1 a výš. Toto rozdělení je 

způsobeno odlišným zpracováním těchto verzí pro práci s programovacím jazykem 

Python v rámci psaní podmínek pro vytváření nových atributů. 

Skript je univerzální pro všechny verze ArcGIS. Ořezy vybraných vrstev třídí 

podle unikátního kódu obce obsaženého v názvu vrstvy. Společně s dalšími vrstvami 

nesoucími stejný kód v názvu vytváří skupinu, která vstupuje do samostatného 

projektu mxd a exportuje z něj soubor ve formátu pdf.  

5.3 Popis modelů pro vytvoření tabulek 

Jednotlivé modely jsou rozděleny do tří toolsetů. Struktura každého toolsetu je 

obdobná. Skládá se ze tří typů modelů, které plní stejnou funkci v rámci každého 

toolsetu. 

Podrobný popis bude uveden na příkladu prvního toolsetu s modely 

pro vytvoření tabulek jednotlivých obvodů. U zbylých toolsetů bude upozorněno 

na případné odlišnosti. 

5.3.1 Modely pro vytvoření tabulek jednotlivých obvodů 

 

Model pro tvorbu dílčích tabulek 

Model vytváří dílčí tabulky ke každému zásahovému obvodu. Z tohoto modelu je 

vytvořeno 10 dílčích tabulek, které jsou připravené ke konečnému sloučení v rámci 

dalšího nástroje. 
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Na začátku modelu je vybrán příslušný zásahový obvod pomocí nástroje „Select“. 

Tento výběr je uskutečněn přes podmínku, která je psána jednoduchým SQL dotazem. 

Dotaz se skládá ze tří částí: 

 název atributu uvedený v dvojitých uvozovkách “ “ (v tomto případě 

atribut nesoucí názvy hasebních obvodů), 

 matematické vyjádření vztahu (=, <, >, <>, …), 

 vybraná entita uvedená v jednoduchých uvozovkách ‘ ‘ (příslušný 

zásahový obvod). 

Výstupní vrstva výběru je uložena do pracovní geodatabáze. Ta je ve zbytku 

modelu odkazována pomocí vnitřní proměnné (%NazevDatabaze%).  

Vrstva výběru dále vstupuje do průniku s vrstvou obcí přes nástroj „Intersect“. 

Tento nástroj vytváří průnik jedné vrstvy pomocí další vstupní vrstvy. Nezáleží na pořadí 

těchto vrstev.  

 Výsledná vrstva je opět upravena pomocí výběru, tentokrát podle obcí 

nad rozlohu 395 330 m2. Tato podmínka byla stanovena podle rozlohy nejmenší obce 

ve Zlínském kraji. Tento mezikrok je důležitý z hlediska neshodující se hranice obcí 

s hranicemi zásahových obvodů. Vrstva obvodů byla tvořena nad jinou vrstvou, která 

měla hranice generalizované. Po konzultaci s HZS Zlínského kraje byl do modelu vložen 

tento výběr, aby se docílilo správnosti výsledných dat. 

 

Obr. 3 První část modelu pro vytvoření dílčích tabulek. 

 

Takto upravená vrstva vstupuje do dalších průniků s vybranými vrstvami. Ty 

jsou zvoleny jako parametry modelu. Jedná se o lesy s křovinatým porostem a lesy 

se stromy, záplavové území Q100, budovy, železnice, silnice a o pět výběrů kategorií 

Jednotek požární ochrany ve Zlínském kraji z příslušné vrstvy (JPOII, JPOIII, JPOIV, 

JPOV a JPOVI). Výběr kategorií JPO je uskutečněn z důvodu pozdějšího zjištění počtů 

těchto jednotek na území každé obce. 

Některé z průniků jsou před samotným sloučením upraveny. Průnik lesů 

s křovinatým porostem a průnik lesů se stromy je sloučen do jedné vrstvy lesů pomocí 

nástroje „Merge“. Průnik silnic je upraven na výběr dálnic, rychlostních komunikací 

a silnic 1. – 3. třídy pomocí SQL dotazu omezující nežádoucí kategorie:  

 "TYP_K" <> 'Sn' AND ("TYP_K" <> 'Svv' AND "TYP_K" <> 'Unsj' AND "TYP_K" 

<> 'Usj'). 

Vrstvy dále vstupují do sloučení podle atributu s názvy obcí přes nástroj 

„Dissolve“. Některé obce mají své katastrální území rozdělené do více částí, proto byl 

jako atribut pro sloučení zvolený název obce. Aby byla dosažená možnost využití 



39 

v případě změny názvu, byl atribut pro sloučení zvolený jako parametr modelu. 

Současně v rámci tohoto nástroje jsou z příslušných atributů vypočítány sumy ploch 

nebo délek, popř. počty JPO v obci.  

 

Obr. 4 Zadání výpočtu požadovaných hodnot z vybraných atributů. 

V posledním kroku jsou výsledné vrstvy převedeny na tabulky pomocí nástroje 

„Table to Table“. Výstupní uložiště dílčích tabulek je geodatabáze, která nesmí být 

shodná se souborovou geodatabází pro ukládání pracovních výstupů (mezivýsledků) 

modelu z důvodu prohledávání tohoto uložiště pomocí iterátoru. Toto uložiště je dalším 

parametrem.  

Jelikož jsou vstupní hodnoty uváděny v m nebo m2, jsou tyto hodnoty v závěru 

přepočteny na km a km2. S tím je spojeno přidání nového pole do tabulky pomocí 

nástroje „Add Field“ a vypočítání rozlohy do nově přidaného pole přes nástroj „Calculate 

Field“ pomocí znalostí převodů jednotek. Pole s hodnotou v m nebo m2 je v dalším kroku 

odstraněno pomocí nástroje „Delete Field“. 

 

 

 

Obr. 5 Náhled na kompletní model pro vytvoření dílčích tabulek jednotlivých obvodů. 
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Obr. 6 Rozhraní modelu pro vytvoření dílčích tabulek jednotlivých obvodů. 

Model pro sloučení dílčích tabulek do výsledné tabulky a vnořený model 

Model vytváří konečné tabulky zásahových obvodů. Lze jej rozdělit do tří částí.  

V první části je vytvořena podkladová tabulka k připojení dílčích tabulek. 

Nejprve je vytvořen výběr hasebního obvodu, který dále vstupuje do průniku s vrstvou 

obcí. Tato vrstva je opět ošetřena výběrem obcí s rozlohou nad 395 330 m2 a je 

převedena na tabulku. Nástroje pro provedení těchto operací jsou shodné s nástroji 

použitými v předchozím popisu. Parametry v této části modelu jsou následující: 

 geodatabáze pro uložení mezivýsledků, 

 podmínka pro výběr hasebního obvodu, 

 vstupní vrstva hasebních obvodů, 

 název výstupní vrstvy vybraného obvodu, 

 vstupní vrstva obcí, 

 název podkladové tabulky, 

 uložiště konečné tabulky. 

Geodatabáze pro uložení mezivýsledků je opět odkazována přes vnitřní 

proměnnou. Uložiště pro konečné tabulky se nesmí shodovat s uložištěm pro tabulky 

dílčí ani pro mezivýsledky. Při uložení do geodatabáze s dílčími tabulkami se naskytl 

problém se selháním modelu při samotném připojení dílčích tabulek.  

Jelikož jsou některé katastrální území obcí rozděleny do více částí (dle vstupní 

vrstvy obcí), byl tento výběr následně upraven pomocí nástroje „Dissolve“. Zde bylo 
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nastaveno sloučení podle atributu s názvem obcí a ponechány další dva potřebné 

atributy, a to název ORP a okresu, ve kterém se daná obec nachází.  

 

Obr. 7 První část modelu s vytvořením podkladové tabulky. 

 

Ve druhé části nástroje tato podkladová tabulka vstupuje do vnořeného modelu, 

který obsahuje iterátor na procházení dílčích tabulek („Iterate Tables“) a nástroj 

pro jejich připojení („Join Field“).  

Vnořený model zde byl použit z důvodu přepisování řádků ve výsledné tabulce. 

Aby bylo možné vnořený model správně umístit a pracovat s ním v jiném modelu jako 

s nástrojem, je třeba vhodně zvolit jeho parametry. Jako parametry je nutné zvolit: 

 podkladovou tabulku,  

 atributy pro připojení z podkladové tabulky,  

 databázi s dílčími tabulkami, 

 výstupní tabulku. 

Do nástroje „Join Field“ vstupují k připojení tabulky z uložiště dílčích tabulek 

určitého zásahového obvodu. Toto uložiště je procházeno pomocí iterátoru k tomu 

určeného. 

 

Obr. 8 Vložený model s iterátorem a nástrojem "Join Field". 
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V poslední části modelu je k výsledné tabulce přidán nový atribut pomocí 

nástroje „Add Field“ pro výpočet plochy obce v km2. Tento výpočet je proveden pomocí 

nástroje „Calculate Field“. Nakonec jsou z této tabulky vymazány přebytečné atributy 

pomocí nástroje „Delete Field“. Jedná se duplicitní atributy s názvy zásahových obvodů, 

které byly připojeny s dalšími atributy v rámci operace „Join Field“ a o atribut s plochou 

obce v m2. Při připojení výsledné tabulky do tohoto nástroje je zvolena navíc možnost 

„Precondition“, která zabrání vstupu tabulky aniž by nebyla naplněna. 

Výsledkem tohoto modelu je jedna výsledná tabulka obsahující požadované 

informace. 

 

Obr. 9 Druhá část modelu pro vytvoření konečných tabulek. 

 

 

Obr. 10 Třetí část modelu pro vytvoření konečných tabulek. 

 

Obr. 11 Náhled na celý model pro tvorbu konečných tabulek zásahových obvodů. 
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Obr. 12 Rozhraní modelu pro tvorbu konečných tabulek zásahových obvodů. 

 

5.3.2 Modely pro vytvoření tabulky za všechny obvody 

Model pro tvorbu dílčích tabulek 

Model vytváří opět dílčí tabulky, které budou připraveny pro konečné sloučení. 

Model je víceméně obdobný modelu pro tvorbu dílčích tabulek jednotlivých obvodů. 

Určité odlišnosti se zde ovšem objevují. 

Nejprve je zde vynechán počáteční výběr hasebního obvodu a průnik s vrstvou 

obcí. Do průniků s vybranými vrstvami vstupuje celá vrstva hasebních obvodů.  

Průnik s obcemi je vytvořen až na stejné úrovni s ostatními průniky. Opět je tato 

vrstva ošetřena výběrem obcí s rozlohou nad 395 330 m2. Z této vrstvy je při sloučení 

zjišťován počet obcí v daném obvodu. 

Model je opět parametrický. Na rozdíl od předchozího modelu pro tvorbu dílčích 

tabulek jednotlivých obvodů je parametrů podstatně méně: 

 výstupní geodatabáze pro mezivýsledky, 

 vstupní vrstva hasebních obvodů, 

 vstupní vrstvy do průniků, 

 atribut pro sloučení vrstev, 

 uložiště výsledné tabulky. 
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Obr. 13 Náhled na model pro tvorbu dílčích tabulek všech zásahových obvodů. 

 

 

 

 

Obr. 14 Vrstva obcí na úrovni s ostatními průniky. 
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Obr. 15 Rozhraní modelu pro tvorbu dílčích tabulek všech obvodů. 

Model pro sloučení dílčích tabulek do výsledné tabulky a vnořený model 

Model se liší od předchozí verze pouze při tvorbě podkladové tabulky. Tabulka je 

vytvořena z vrstvy hasebního obvodu. Odlišný je tudíž i atribut sloužící k připojení 

dílčích tabulek. Vnořený model je beze změny. 

Při odstraňování nadbytečných atributů jsou mazány duplicitní názvy obvodu 

a plocha v m2. 

 

Obr. 16 Náhled na model pro vytvoření tabulky zásahových obvodů Zlínského kraje. 
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Obr. 17 Rozhraní modelu pro vytvoření konečné tabulky všech hasebních obvodů. 

 

5.3.3 Modely pro vytvoření všech tabulek 

Po vzájemné konzultaci s Hasičským záchranným sborem Zlínského kraje byla 

vytvořena třetí verze předešlých modelů. Každý nově vytvořený model obsahuje kroky 

pro sestavení všech tabulek bez nutnosti opakovat spuštění modelu pro každý zásahový 

obvod zvlášť, jako tomu je u modelů v toolsetu pro vytvoření dílčích a výsledných 

tabulek jednotlivých obvodů.  

Pro vytvoření dílčích tabulek všech zásahových obvodů, v co nejmenším počtu 

opakování, je model pro jednotlivé zásahové obvody rozkopírován třináctkrát do čtyř 

modelů a doplněn o model pro tvorbu konečných tabulek všech hasebních obvodů. Tím 

je docíleno vytvoření sad tabulek pro každý zásahový obvod v rámci pěti kroků (čtyři 

spuštění modelu pro dílčí tabulky a jedno spuštění modelu pro konečné tabulky). To 

vede k úspoře času, který je potřebný při práci s modely. 

Stejný princip rozkopírování a úpravy nástroje pro sloučení tabulek je 

i u druhého modelu. Vnořený model zůstává pouze jeden, jelikož je parametrický 

a potřebné vstupní hodnoty jsou voleny v modelu hlavním, kde je s vnořeným modelem 

pracováno jako s dalším z nástrojů. 

5.4 Popis modelů pro vytvoření ořezů vybraných vrstev 

Z technických důvodů byly v rámci toolboxu pro vytvoření ořezů vybraných 

vrstev vytvořeny dva modely. Jeden model pro verzi ArcGIS 10.0 a druhý pro verzi 

ArcGIS 10.1 a výš. Modely jsou obdobné, liší se pouze ve skriptu pro výpočet nové 

hodnoty pole přes programovací jazyk Python. Nové pole má obsahovat názvy obcí 

bez diakritiky a mezer, které budou nahrazeny podtržítkem, aby bylo použito jako 

součást názvu výsledných vrstev. 

Až od verze 10.1 není problém s řetězci Unicode a jsou plně podporovány. 

V modelu pro verzi 10.1 bylo této vlastnosti využito. Pro verzi 10.0 byl vytvořen kód 

pro výpočet nové hodnoty pomocí programovacího jazyka Python méně elegantním 

způsobem, kdy jsou pevně stanoveny znaky, které mají být převedeny na znaky 

bez diakritiky (viz Obr. 19 a Obr. 20). 
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Model pro verzi ArcGIS 10.0 

Model vytváří ořezy vybraných vstupních vrstev podle katastrálního území každé 

obce ve Zlínském kraji. Každá takto vzniklá vrstva nese v konečném názvu unikátní kód 

obce pro pozdější operaci s vrstvami. 

Nejprve jsou vybrány obce, které se nacházejí ve Zlínském kraji přes nástroj 

„Select“. Tento výběr je následně upraven. K této vrstvě je přidán nový atribut pomocí 

nástroje „Add Field“ pro vytvoření nového pole, do kterého bude uloženo pojmenování 

obcí bez diakritiky. U více slovního pojmenování je mezera nebo spojovník mezi slovy 

nahrazena podtržítkem. Toto přejmenování je prováděno pomocí nástroje „Calculate 

Field“ přes podmínku v programovacím jazyce Python. 

Takto upravená vrstva vstupuje do iterátoru na procházení řádků vrstvy („Iterate 

Row Selection“). U hodnoty Group by Field v tomto iterátoru je zvolen nejen název obce, 

ale i kód obce. Kód je unikátní pro každou obce. Ve Zlínském kraji se nachází několik 

obcí se stejným názvem. Název (upravený bez diakritiky) je vybrán pro lepší orientaci 

mezi výslednými vrstvami. Tento výběr vstupuje do názvu výsledných vrstev pomocí 

vnitřní proměnné %Value%. 

Podle jednotlivých obcí z iterátoru je ořezána každá zájmová vrstva. Celkem je 

v rámci tohoto modelu vytvořeno asi 2 700 vrstev.  

 

Obr. 18 Náhled na model pro vytvoření ořezů vybraných vrstev. 
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Obr. 19 Náhled na rozhraní výpočtu nové hodnoty pro verzi ArcGIS 10.0. 

 

Obr. 20 Náhled na rozhraní výpočtu nové hodnoty pro verzi 10.1 a výš. 

  

Kód podmínky pro verzi ArcGIS 10.0 

 

def replaceDiacritic(text = "", replaceSpaces = False): 

    target = u"áäčďéěíĺľňóôőöŕšťúůűüýřžÁÄČĎÉĚÍĹĽŇÓÔŐÖŔŠŤÚŮŰÜÝŘŽ" 

    replacer = u"aacdeeillnoooorstuuuuyrzAACDEEILLNOOOORSTUUUUYRZ" 

  

    for i in range(0, len(text), 1): 

        if text[i] in target: 

            text = text.replace(text[i], 

replacer[target.index(text[i])]) 

  

    if replaceSpaces: 

        text = text.replace(' ', '_') 

    text = text.replace('-', '_') 

 

    return text 

 

replaceDiacritic( unicode(!NAZ_OBEC_P!), True) 
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Kód podmínky pro verzi ArcGIS 10.1 a výš 

 

import unicodedata 

def remove_accents(input_str, replaceSpaces): 

 

    try: 

        input_str = unicode(input_str, "UTF8") 

    except: 

        input_str = unicode(input_str) 

 

    nkfd_form = unicodedata.normalize('NFKD', input_str) 

    only_ascii = nkfd_form.encode('ASCII', 'ignore') 

 

    if replaceSpaces: 

        only_ascii = only_ascii.replace(' ', '_') 

  only_ascii = only_ascii.replace('-', '_') 

 

    return only_ascii 

 

remove_accents(!NAZ_OBEC_P!, True) 

 

5.5 Popis skriptu 

Pro vytvoření projektů mxd a souboru pdf pro každou obec s příslušnými 

vrstvami je vytvořen skript v programovacím jazyce Python s využitím nástrojů modulu 

„mapping“. 

Před samotným spuštěním skriptu je třeba vytvořit jeden projekt, který bude mít 

správně nastavenou symbologii, pořadí vrstev, měřítko a v Layoutu bude předchystána 

legenda a měřítko. Takto upravený projekt bude sloužit jako předloha pro ostatní 

projekty. 

Pořadí vrstev bylo zvoleno v závislosti na správnosti překrývání se vrstev. 

Na nejnižší úroveň byla postavena vrstva s lesy, nad ní vodní toky a vodní plochy, 

železnice, silnice a budovy. Pro mapové výstupy bylo zvoleno jednotné měřítko 

1 : 30 000 a formát Layoutu A4. Z toho důvodu bylo nutné cca 60 mapových výstupů 

opravit. V těchto případech se jednalo o rozlehlejší obce, které přesahovaly 

přednastavený formát. Ten byl upraven na velikost odpovídající A3.  

Samotný skript (kód skriptu viz Příloha 6) prochází výstupní databázi s ořezy 

vrstev. Jelikož každá vrstva obsahuje unikátní část názvu (kód obce), lze vytvořit 

sloučení vrstev podle toho kódu. Vrstvy jsou roztříděny do samostatných projektů. 

Pořadí vrstev, symbologie, legenda a měřítko je převzato z projektu sloužícího jako 

předloha. Každý projekt je pak unikátně pojmenován a uložen do nadefinovaných 

adresářů k tomu učených. 

Kromě uložení samotného projektu ve formátu mxd je vyexportována i mapa 

ve formátu pdf. Tento soubor je opět unikátně pojmenován. Mapové výstupy budou dále 

využity při tvorbě karet obcí (viz kapitola 6). 
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6 KARTY OBCÍ 

Pro vytvoření karet obcí byl námětem Informační systém Karty obcí 

Olomouckého kraje. „Ten slouží ke sběru dat a následně pro přístup k datům 

o jednotlivých obcích Olomouckého kraje pro potřeby krizového řízení, operačního 

řízení, jako seznam kontaktů a osob, atd.“ (Bartečko, 2009) 

„Jsou sbírány informace o obcích (Základní informace o obci, starosta, 

místostarosta; Spojení; Ohlašovny požáru; Zdroje požární vody), o varování 

a vyrozumění (Sirény; Celkové pokrytí systémem sirén; Rozhlas; Jiný způsob varování; 

Pokrytí mobilními operátory), o silách a prostředcích (Autobusy a mikrobusy; Nákladní 

automobily; Traktory a pojízdné pracovní stroje; Služby, síly a prostředky v obci; 

Humanitární organizace a občanská sdružení), o významných objektech (Školy; Sociální 

zdravotnická a veterinární zařízení; Ubytování a stravování; Objekty AČR; Velkosklady), 

o ohrožujících objektech (Čerpací stanice; Skládky odpadu; Ohrožující velkosklady; 

Objekty s možností shromáždění velkého počtu osob - nad 300), o JPO (JPO; Členové 

jednotky; Kontakty pro vyhlášení poplachu; Vozidla; Technika), o orgánech KŔ (Členové 

bezpečnostních rad obce, popř. krizový štáb, povodňová komise a funkce těchto členů), 

informace o přehledech (Přehledy osob, adresných míst, objektů, organizací, subjektu, 

sirén, techniky, vozidel; Statistiky naplnění dat; exporty vybraných dat pro operační 

řízení (obce a členové JPO, atd.).“(Bartečko, 2009) 

Pro účely bakalářské práce byly karty obcí upraveny a zjednodušeny. 

Shromažďovány jsou základní údaje o obci, jako informace o počtu obyvatel, rozloze 

obce, rozloze zastavěné plochy (plocha zabrána budovami), ploše lesů, ploše 

záplavového území Q100, kategorie JPO, zda je v obci školní zařízení a o jaké zařízení se 

jedná. Vše je doplněno o kontakty na starostu obce a velitele JPO.  

Karty jsou očíslovány a seřazeny podle abecedního pořadí obcí ve Zlínském kraji. 

Doplněny jsou o mapový výstup v měřítku 1 : 30 000 z vyexportovaných pdf a legendu 

s měřítkem pomocí vytvořeného skriptu. U každé karty je umístěna i přehledná mapa 

Zlínského kraje v měřítku 1 : 1 500 000 s vyznačenou polohou dané obce. Rozložení 

karty je zřejmé z šablony (viz Příloha 7). 
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7 VÝSLEDKY 

Výsledky bakalářské práce lze rozdělit na toolboxy obsahující modely a skript, 

tabulky, které pomocí těchto nástrojů jsou vyplňovány, mapové výstupy a karty obcí. 

V neposlední řadě je vytvořen manuál a uživatelská příručka k obsluze toolboxů. 

7.1 Výsledné toolboxy, modely a skript 

V této práci byly vytvořeny dva toolboxy s odlišným zaměřením (viz Obr. 2). První 

toolbox s označením „Tvorba ořezů vybraných vrstev a map“ obsahuje dva modely 

pro tvorbu ořezů a jeden skript pro roztřídění těchto výsledných vrstev do projektů mxd 

a vyexportování souborů pdf. 

Druhý toolbox nese označení „Tvorba tabulek zásahových obvodů“. Obsahuje tři 

toolsety. První je zaměřený na modely pro jednotlivé zásahové obvody, druhý na modely 

vytvářející sumarizační tabulku všech zásahových obvodů a třetí pro ulehčení práce 

Hasičského záchranného sboru Zlínského kraje obsahuje modely, které vytvářejí 

všechny výsledné tabulky bez nutnosti opakovaného použití modelu.    

Toolboxy obsahují celkem 14 dílčích modelů. Tyto modely lze rozdělit do čtyř 

typů podle výstupů. První typ modelu vytváří ořezy vybraných vrstev (viz Obr. 18). 

Do tohoto typu lze zařadit oba dva modely z toolboxu „Tvorba ořezů vybraných vrstev 

a map“: 

 „Model_pro_tvorbu_orezu_verze_pro_10.0“, 

 „Model_pro_tvorbu_orezu_verze_pro_10.1_a_vys“. 

Odlišnosti modelů jsou blíže popsány v podkapitole 5.4.  

Druhý typ modelu vytváří dílčí tabulky, které jsou připravené k následnému 

sloučení do konečných tabulek. Do tohoto typu lze zařadit modely z toolboxu „Tvorba 

tabulek zásahových obvodů“: 

 „Model_jednotlive_obvody_dilci_tabulky“ (viz Obr. 5),  

 „Model_pro_tvorbu_dilcich_tabulek_bystrice_holesov_kromeriz“, 

 „Model_pro_tvorbu_dilcich_tabulek_luhacovice_vsetin_zlin“, 

 „Model_pro_tvorbu_dilcich_tabulek_morkovice_otrokovice_slavicin“, 

 „Model_pro_tvorbu_dilcich_tabulek_brod_hradiste_klobouky_mezirici“, 

 „Model_zasahove_obvody_zl_kraj_dilci_tabulky“ (viz Obr. 13). 

Třetí typ modelu vytváří konečné tabulky zásahových obvodů. Tento typ modelů 

se objevuje v toolboxu „Tvorba tabulek zásahových obvodů“: 

 „Model_s_iteratorem_join_field_obvody_jednotlive“ (viz Obr. 11),  

 „Model_s_iteratorem_join_field_pro_vsechny_tabulky_obvodu“,  

 „Model_s_iteratorem_join_field_obvody_kraj“ (viz Obr. 16). 

Čtvrtý typ modelu je model vnořený. Tento model je součástí třetího typu 

modelu, ve kterém funguje jako jeden z nástrojů. Je totožný ve všech částech toolboxu 

„Tvorba tabulek zásahových obvodů“ (viz Obr. 8). Jedná se o modely: 

 „Vnoreny_model_join_field_s_iteratorem_obvody_jednotlive“, 

 „Vnoreny_model_join_field_s_iteratorem“, 

 „Vnoreny_model_join_field_s_iteratorem_obvody_kraj“. 

Poslední součástí toolboxu je skript, který roztřídí ořezy vybraných vrstev podle 

unikátního kódu obce obsaženého v názvu výstupní vrstvy do projektů mxd. V každém 

projektu je vrstvám nadefinováno pořadí, symbologie a měřítko podle předlohy 
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(samostatně vytvořeného modelu). Na závěr je mapa z projektu vyexportována 

ve formátu pdf.  

Všechny toolboxy, modely i skript jsou podrobněji popsány v 5. kapitole. 

7.2 Výsledné tabulky 

Pomocí modelů bylo vytvořeno celkem 14 výsledných tabulek zásahových obvodů 

(náhled na ukázku viz Příloha 8). Požadavky na zjišťované atributy byly vzneseny 

ze strany Hasičského záchranného sboru Zlínského kraje. Výsledné tabulky lze opět 

rozdělit do dvou typů podle obsahu. 

První tabulky se týkají jednotlivých zásahových (hasebních) obvodů ve Zlínském 

kraji. Těchto obvodů je celkem 13:  

 Bystřice pod Hostýnem, 

 Holešov, 

 Kroměříž, 

 Luhačovice, 

 Morkovice-Slížany, 

 Otrokovice, 

 Slavičín, 

 Uherské Hradiště, 

 Uherský Brod, 

 Valašské Klobouky, 

 Valašské Meziříčí, 

 Vsetín, 

 Zlín. 

V každé tabulce jsou zjišťovány informace pro obce nacházející se v daném 

obvodu: 

 ORP, ve kterém se obec nachází, 

 okres, 

 plocha obce, 

 zastavěná plocha (plocha zastavěná budovami), 

 délka silnic (dálnice, rychlostní komunikace, silnice 1. – 3. třídy), 

 délka železnic, 

 plocha lesů, 

 plocha Q100, 

 počty JPO II, JPO III, JPO IV, JPO V a JPO VI. 

Druhý typ tabulky je tabulka sumarizační pro všechny obvody ve Zlínském kraji. 

Pro každý obvod jsou zjišťovány následující informace: 

 plocha obvodu, 

 počet obcí, 

 zastavěná plocha, 

 délka silnic (dálnice, rychlostní komunikace, silnice 1. – 3. třídy), 

 délka železnic, 

 plocha Q100, 

 plocha lesů, 

 počty JPO II, JPO III, JPO IV, JPO V a JPO VI. 
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Všechny tabulky budou opakovaně vyplňovány každý rok pracovníky 

Hasičského záchranného sboru Zlínského kraje. 

7.3 Karty obcí a mapové výstupy 

Nedílnou součástí výstupů bakalářské práce jsou karty obcí v elektronické 

podobě. Tyto karty obcí budou použity pro řešení mimořádných situací v rámci 

krizového řízení Hasičského záchranného sboru Zlínského kraje. Celkový počet karet 

odpovídá počtu obcí ve Zlínském kraji, tudíž se jedná o 307 karet. 

Karty obcí jsou strukturovány jako základní přehled o jednotlivých obcích 

ve Zlínském kraji. Hlavní část karty zaujímá mapový výstup vytvořený pomocí 

vytvořeného skriptu. Tato mapa je doplněna o legendu a měřítko. Mapy jsou 

v jednotném měřítku 1 : 30 000.  

Doplněny jsou základní informace o obci a její vybavenosti společně s kontakty 

na starostu obce a velitele JPO. Mezi informace, které jsou pro každou obec zjišťovány, 

patří: 

 počet obyvatel,  

 rozloha obce, 

 rozloha zastavěné plochy (plocha zabrána budovami), 

 plocha lesů,  

 plocha záplavového území Q100,  

 kategorie JPO, 

 zda je v obci školní zařízení a o jaké zařízení se jedná.  

Karty obcí jsou abecedně seřazeny a každá karta je doplněna o přehledovou 

mapu s pozicí vybrané obce ve Zlínském kraji. 

 

7.4 Manuály a uživatelská příručka 

Pro ulehčení obsluhy modelů i po roční odmlce mezi periodickým vyplněním 

tabulek zásahových obvodů byla sestavena krátká uživatelská příručka k vytvořeným 

modelům, která z velké části odkazuje na sestavené nápovědy ke každému modelu. 

Mimo to proběhne i zaškolení. V případě zájmu o sestavení podobných modelů, popř. 

o jejich úpravu, je vytvořen manuál pro tvorbu všech potřebných modelů k vytvoření 

konečné podoby tabulek a modelu pro ořezy vrstev. 
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8 DISKUZE 

Tato bakalářská práce se zabývá sestavením modelů v prostředí ArcGIS 

umožňujících periodické vyplnění tabulek zásahových obvodů Zlínského kraje 

a vytvoření ořezů vybraných vrstev podle katastrálního území jednotlivých obcí, které se 

v daném kraji nacházejí. 

Během vytváření modelů jsem se potýkala s řadou problémů týkajících se nejen 

jejich funkčnosti, ale i správnosti výstupů. Problémy s funkčností byly konzultovány 

s panem Mgr. Filipem Jungem. Původní verze modelu nebyla rozdělena do tří částí. 

Jednalo se o model, který byl doplněn na konci každé tabulky o nástroj „Join Field“, 

který ovšem umožňuje spojení pouze dvou vstupních vrstev. Z důvodu nutnosti 

opakovaného vkládání tohoto nástroje až k finální tabulce, se model rozrůstal 

do nežádoucích rozměrů. Proto bylo vyzkoušeno efektivnější řešení pomocí iterátorů. 

S tím se vyskytly první problémy s funkčností. Při vložení iterátoru do stejného 

modelu, který vytváří dílčí tabulky, se objevil problém s předbíháním se iterátoru, který 

měl pracovat s tabulkami vytvořenými jinými nástroji v modelu. Tudíž docházelo k jeho 

selhání. Aby se předešlo tomuto předbíhání, byl model rozdělen do dvou částí. První 

model pro vytvoření samostatných dílčích tabulek, druhý s iterátorem pro jejich spojení. 

Další problém se týkal nechtěného přepisování řádků výstupní tabulky v rámci 

modelu s iterátorem. Aby bylo toto přepisování ošetřeno, musel být přidán třetí, 

vnořený, model. Jednalo se o model, který by vstupoval jako nástroj do jiného modelu. 

V těle vnořeného modelu musí být umístěny všechny nástroje, do kterých se mají 

zapojit vrstvy vystupující z iterátoru. Následně bylo nutné u tohoto modelu vhodně 

zvolit parametry, aby bylo možné tento model použít jako nástroj v těle modelu 

předchozího. 

Tím bylo docíleno vytvoření tří typů modelů pro sestavení konečných výsledných 

tabulek zásahových obvodů. 

Tento počet modelů nebyl konečný, protože tabulky zásahových obvodů, které 

bylo třeba vyplnit, lze rozdělit na dvě odlišné verze. První, která zjišťuje informace 

týkající se obcí v jednotlivých zásahových obvodech, a druhá, která je sumarizační 

tabulkou těchto obvodů. Z tohoto důvodu byly vytvořené modely upraveny pro první 

i druhou verzi tabulek. 

Modely jsou parametrické. Jelikož se na území Zlínského kraje nachází 13 

zásahových obvodů, bylo by nutné tuto operaci opakovat do dosažení konečného počtu 

tabulek. Tato skutečnost byla po konzultaci s paní por. Ing. et Bc. Janou Štěpánů 

z HZS Zlínského kraje námětem pro vytvoření dalších čtyř modelů, které budou 

obsahovat model rozkopírován a upraven pro každý hasební obvod. Rozdělení do čtyř 

modelů bylo jednak z důvodu přehlednosti, jednak z důvodu obsáhlosti nástroje, který 

by tvořil veškeré dílčí tabulky v jednom kroku. 

S paní Štěpánů byly konzultovány i problémy se správností výstupů některých 

operací a požadavků na omezení některých vstupních vrstev. Přesněji se jednalo 

o neshodující se průběh hranic obcí s hranicemi hasebních obvodů. Tento problém 

vznikl při digitalizaci hasebních obvodů nad vrstvou, která měla hranice do určité míry 

generalizované. Proto bylo rozhodnuto o upravení výstupů obcí jejich výběrem 

nad rozlohu nejmenší části obce. Dalším důležitým požadavkem bylo sloučení dvou 

různých vrstev lesů do jedné vrstvy a upravení výběru kategorií silnic, se kterými se 

bude dále pracovat, a to pouze na dálnice až silnice 3. třídy. Omezení se týkalo 

kategorie nezpevněných komunikací a ulic. 
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Pro případ nutnosti upravení pouze tabulky některého zásahového obvodu, byl 

ponechán ve výsledcích bakalářské práce i model původní (pro jeden zásahový obvod). 

Vyplnění tabulek provádí paní por. Ing. et Bc. Jana Štěpánů každým rokem. Jedná se 

o datovou analýzu se snahou vybudovat si určitý přehled o daném území. 

V rámci řešení funkčnosti modelu pro vytvoření ořezů vybraných vrstev jsem 

se setkala s problémem při výpočtu hodnoty nového pole, které mělo přebrat názvy 

obce, ale odstranit diakritiku, a mezery a spojovníky mezi dílčími názvy obce nahradit 

podtržítkem. K tomuto účelu byl sestaven kód v programovacím jazyce Python, který byl 

následně vložen do tohoto nástroje. Problém se objevil při ověření funkčnosti 

na různých verzích aplikace ArcGIS. Od verze 10.1 je plně podporován řetězec Unicode 

a práce s ním. Do této verze je potřeba tento problém ošetřit. Proto byly sestaveny dva 

modely. Další problém nastal se samotným kódováním textového řetězce v atributové 

tabulce s názvy obcí. Některé entity ArcGIS nedokázal v rámci Unicode rozlišit, proto 

bylo nutné opět původní podmínku upravit. 

Tento model vytvořil okolo 2 700 samostatných vrstev. Při ručním třídění vrstev 

do skupin pro každou obec by se jednalo o velmi zdlouhavou práci. Ve snaze o ulehčení 

si práce byl sestaven skript, ve kterém byly použity nástroje z modulu „mapping“, který 

zvládá hned několik kroků v rámci jednoho spuštění a vytváří tak pro každou obec 

projekt mxd s příslušnými vrstvami a mapové výstupy z těchto projektů exportuje 

do pdf formátu. Z důvodu použití karet pouze v elektronické podobě nebyly barvy 

exportovány v barevné syntéze CMYK, ale v RGB.  

Měřítko map bylo stanoveno na 1 : 30 000. Z důvodu odlišné velikosti území 

obcí, byly některé pdf soubory nutné opravit ručně. Bylo třeba změnit velikost Layoutu 

a mapu znovu vyexportovat. Řádově se jednalo o několik desítek obcí. Rozšíření skriptu 

o automatickou úpravu Layoutu by mohlo být námětem některé další studie nebo 

práce. 

Modely byly úspěšně otestovány na pracovišti Hasičského záchranného sboru 

Zlínského kraje, kde mají k dispozici ArcGIS ve verzi 10.0. Problémy, které nastaly, byly 

způsobeny špatným nastavením cest k datům vstupujícím do modelů. Mimo to 

proběhne zaškolení. 

Karty obcí byly vytvořeny po vzoru Informačního systému „Karty obcí“ 

Olomouckého kraje. Po vzájemné domluvě s krizovým řízením byly vybrány pouze 

informace nejzákladnějšího rázu. V rámci jiné bakalářské nebo diplomové práce by bylo 

možné rozšířit karty obcí o veškeré informace uváděné v předloze u Olomouckého kraje. 

Dále by bylo možné vytvořit pro HZS Zlínského kraje webovou aplikaci nebo nadstavbu, 

která by byla využita v rámci Intranetu HZS Zlínského kraje. Zatím budou karty 

využívány v domluveném rozsahu při řešení mimořádných událostí většího rozsahu. 

U některých mapových výstupů jsem si vědoma viditelných hranic lesů, které 

zůstaly ponechány z důvodu zachování pdf z projektů mxd. Tento problém by šel vyřešit 

sloučením vrstev lesů. Jednalo by se o doplnění této operace do modelu nebo skriptu. 

V rámci teoretické části je nutné zmínit důvody rozhodnutí rozeslání dotazníků 

pouze na krajská pracoviště hasičských záchranných sborů. Bylo tak učiněno 

po nastudování si struktury HZS, kdy pracovníci GIS jsou situováni na krajských 

pracovištích. Tito pracovníci spadají do oddělení komunikačních a informačních služeb. 

V rámci dotazníku jsem si vědoma špatně položené otázky. Tato otázka se týkala 

počtu zaměstnanců pracujících s GIS na daném pracovišti HZS. Otázka nebyla přesně 

specifikována. Původním záměrem bylo zjištění počtu pracovníků, kteří vytvářejí 

podpůrné materiály a spravují GIS. Do výsledných odpovědí se promítly ovšem i počty 
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pracovníků operačního řízení a Telefonního centra tísňového volání (TCTV) 112, kteří 

pracují s GIS doplněným o nadstavby, např. aplikace pro spojení s pohybem vozidel 

IZS. 

Z důvodu omezení využití dat pouze pro účely bakalářské práce nejsou vstupní 

data uložena v Příloze 11 (DVD). Data budou k dispozici na vyžádání u vedoucího práce 

pana RNDr. Jaroslava Buriana, Ph.D..    
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9 ZÁVĚR 

Cíle bakalářské práce Periodické analýzy a vizualizace dat pro Hasičský 

záchranný sbor lze rozdělit na teoretické v rámci rešeršní části a praktické. 

V rešeršní části bakalářské práce měl být zhodnocen současný stav využívání 

geoinformačních technologií a služeb v Hasičských záchranných sborech v České 

republice. Ke splnění daného cíle bylo využito studie literatury dané problematiky 

doplněné o dotazníkové šetření. Dotazník byl sestaven pomocí formulářů Google 

a elektronicky rozeslán na krajské pracoviště Hasičských záchranných sborů. 

Odpověděly na něj všechny kraje. 

Cílem praktické části bakalářské práce bylo v prostředí ArcGIS sestavit model, 

který umožní opakovaně provádět datové analýzy a vizualizace vybraných dat, které 

využívá Hasičský záchranný sbor Zlínského kraje. Nástroje byly sestaveny přesněji 

v prostředí Model Builder s cílem úspory času a vyšší efektivity práce. Vedle 

sestaveného nástroje byly výsledkem práce také mapové výstupy a tzv. "karty obcí". 

Celkem bylo vytvořeno 14 modelů a jeden skript. Ty byly tematicky rozděleny 

do dvou toolboxů. Jeden se záměrem vytvoření konečných tabulek zásahových obvodů 

Zlínského kraje a sumarizační tabulky, druhý pro vytvoření ořezů vybraných vrstev 

a map pro každou obec ve Zlínském kraji. 

Pomocí skupiny modelů zařazených do tollboxu pro vytvoření tabulek bylo 

vytvořeno celkem 13 tabulek pro obce nacházející se v jednotlivých zásahových 

obvodech a jedna sumarizační tabulka všech zásahových obvodů Zlínského kraje.  

Použitím modelu pro vytvoření ořezů vybraných vrstev je dosaženo 2 700 

výstupů, které jsou pomocí skriptu, sestaveného v programovacím jazyce Python, 

roztříděny do 307 projektů mxd (pro každou obec ve Zlínském kraji jeden projekt mxd). 

Z těchto projektů je automaticky vyexportováno 307 mapových podkladů ve formátu 

pdf. Tyto mapy jsou využity pro karty obcí.  

Celkem je vytvořeno 307 karet obcí, které kromě mapy dané obce obsahují 

základní informace o obci a její vybavenosti, kontaktní údaje na starostu obce a velitele 

Jednotky požární ochrany. Součástí karty je i přehledná mapa Zlínského kraje 

s vyznačenou pozicí dané obce a pořadové číslo karty, které odpovídá abecednímu 

seznamu obcí Zlínského kraje.  

Výsledky práce urychlí vytváření výše zmíněných analýz nad daty. Budou 

poskytnuty s uživatelskou příručkou Hasičskému záchrannému sboru Zlínského kraje. 

Tabulky jsou opakovaně vyplňovány každý rok, s tím je zajištěno opětovné využití 

modelů tohoto typu. Karty obcí budou využívány při řešení mimořádných situací 

většího rozsahu. 
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PŘÍLOHA 5 

 

 



 

 

 

 

 

 



 

PŘÍLOHA 6 

 

Kód skriptu s komentáři 

 

# autor: Markéta Stachová 

# datum: 20. 4. 2015 

 

import arcpy 

import os 

from arcpy import env 

 

# nastavení pracovních adresářů 

 

# nastavení adresáře s databází, kde jsou uloženy dílčí vrstvy 

env.workspace = (r"G:\databaze_bakalarka\mapy_1.gdb") 

# nastavení adresáře, kde je uložena vrstva s unikátními kódy v 

atributové tabulce 

obceFc = r"G:\databaze_bakalarka\obec.gdb\obce" 

 

#nastavení cesty k projektu, který má přednastavenou symbologii, pořadí 

vrstev, legendu, měřítko 

templateDocumentPath = r"G:\projekty\obec_500011_zelechovice.mxd" 

# nastavení adresáře, do kterého se budou ukládat vytvořene projekty mxd 

outFolder = r"G:\projekty" 

 

# nastavení adresáře, do kterého se budou ukládat vytvořené pdf soubory 

outFolder2 = r"G:\pdf" 

 

# definice neznámé kodyObci 

kodyObci = [] 

 

# procházení vrstvy obce a vytvoření seznamu, který obsahuje unikátní 

kódy, dle kterých se budou třídit vstupní vrstvy  

rows = arcpy.SearchCursor(obceFc) 

for row in rows: 

    kodObceStr = str(row.getValue("KOD_OBEC_P")) 

    kodyObci.append(kodObceStr) 

del rows 

 

kodyObci = list(set(kodyObci)) 

 

# procházení databáze s vrstvami a jejich roztříděnní podle unikátního 

kódu do jednotlivých projektů a následné vyexportování do pdf 

templateDocument = arcpy.mapping.MapDocument(templateDocumentPath) 

dbPath = env.workspace 

 

for kodObce in kodyObci: 

    print(kodObce) 

    obecFeatureClasses = arcpy.ListFeatureClasses("*" + kodObce + "*") 

 

    if len(obecFeatureClasses) > 0: 

        # extrakce data frame a vrstvy 

        dataFrame = arcpy.mapping.ListDataFrames(templateDocument)[0] 

 

        for obecFeatureClass in obecFeatureClasses: 

            layerName = obecFeatureClass.split("_")[0] 

            targetLayers = arcpy.mapping.ListLayers(templateDocument, 

layerName) 



 

 

            if len(targetLayers) == 1: 

                targetLayer = targetLayers[0] 

 

                # nahrazení datového zdroje 

                targetLayer.replaceDataSource(dbPath, 

"FILEGDB_WORKSPACE", obecFeatureClass) 

 

                # zoom na extent vrstvy 

                if layerName == "obce": 

                    layerExtent = targetLayer.getExtent() 

                    dataFrame.panToExtent(layerExtent) 

 

        # nastavení měřítka 

        dataFrame.scale = 30000.0 

 

        # uložení kopie dokumentu do výstupní složky s projekty 

        outDocumentPath = os.path.join(outFolder, "obec_" + kodObce + 

".mxd") 

 

        # uložení a přejmenování pdf souboru do výstupní složky 

        outPdfDocument = os.path.join(outFolder2, "obec_"+kodObce + 

".pdf" ) 

        arcpy.mapping.ExportToPDF(templateDocument, outPdfDocument) 

 

 

        templateDocument.saveACopy(outDocumentPath) 

        print("Ulozen dokument {0}".format(outDocumentPath)) 

 

    else: 

        print("Obec {0} nema zadna data".format(kodObce)) 

 

del templateDocument 

 

 

 

 

 

 

 

 

  



 

PŘÍLOHA 7 – ŠABLONA KARET OBCÍ 

 

   



 

PŘÍLOHA 8 

Ukázka tabulky vybraného zásahového obvodu a sumarizační tabulky. 

 

                  



 

PŘÍLOHA 9 - MAUÁLY 

PŘÍPRAVA GEODATABÁZÍ A SEZNÁMENÍ SE 

S VYTVÁŘENÍM TOOLBOXŮ, TOOLSETŮ A MODELŮ 

Vytvoření pracovních databází 

1. Vytvoření pracovní souborové databáze (File geodatabase) na pracovní výstupy 

(mezivýsledky). 

 Vybereme uložiště databáze (adresář) přes Catalog. 

 Pravým tlačítkem myši na adresář-> New -> File geodatabase. 

 

 Přejmenujeme databázi (pravým tlačítkem myši na databázi  -> Rename). 

 

Obdobným způsobem vytvoříme i další tři geodatabáze. 



 

2. Vytvoření pracovní souborové databáze (File geodatabase) na dílčí tabulky, které 

se budou dále slučovat. 

3. Vytvoření pracovní souborové databáze na mezivýsledky z modelu pro sloučení 

tabulek. 

4. Vytvoření pracovní souborové databáze (FIle geodatabase) na konečné tabulky. 

Vytvoření toolboxu 

Vytvoření nového toolboxu. 

a. Otevřeme ArcToolbox. 

b. Pravým tlačítkem myši na ArcToolbox -> Add Toolbox. 

 

c. Poté se otevře nové okno. 

d. Vybereme adresář, do kterého se nový toolbox uloží. 

e. Z horní lišty vybereme ikonu pro vytvoření nového toolboxu. 

 

f. Nový toolbox přejmenujeme a přidáme do ArcToolboxu přes tlačítko 

OPEN. 

 



 

Vytvoření toolsetu 

a. Pravým tlačítkem na toolbox -> New -> Toolset. 

 

b. Vytvořený toolset přejmenujeme. 

 

Vytvoření nového modelu 

a. Pravým tlačítkem myši na Toolset (nebo Toolbox) -> New -> Model. 

 

b. Automaticky se nám otevře pracovní okno Modelu. 

c. Po ukončení pracovního okna Modelu se do tohoto prostředí opětovně 

dostaneme přes možnost Edit (pravým tlačítkem na Model -> Edit). 

 

d. Model přejmenujeme (pravým tlačítkem myši na Model -> Rename). 

 



 

Možnosti přidání nástrojů do modelu 

a. Přetažením vybraného nástroje z ArcToolboxu do pracovního okna Modelu. 

b. Zkopírováním nástroje z jiného modelu a vložení do nového modelu. 

c. Vložení speciálních nástrojů pouze v pracovním okně Modelu. 

i. Insert -> Model Only Tools. 

 

d. Vložení iterátorů. 

i. Insert -> Iterators. 

 

  



 

MANUÁL PRO TVORBU DÍLČÍCH TABULEK 

 

Vytvoříme nový model. 

Model pro jednotlivé hasební obvody 

1. Výběr hasebního obvodu. 

a. Vložíme nástroj „Select“ (výběr). 

i. Analysis Tools -> Extract -> Select 

b. Dvojklikem na nástroj se dostaneme do nastavení nástroje: 

i. Input Features (vstupní vrstva): vrstva s hasebními obvody 

Zlínského kraje. 

ii. Output Feature Class (výstupní vrstva): uložiště nastavíme 

pomocí vnitřní proměnné %VystupniDatabaze% (databáze 

pro mezivýsledky) a vrstvu si výstižně pojmenujeme. 

iii. Expression: “atribut_s_nazvem_hasebnich_obvodu“ =  

‘nazev_hasebniho_obvodu‘ (v našem případě nastavení podmínky 

ne v nastavení nástroje, ale samostatně jako parametru). 

iv. OK 

 

c. Přejmenujeme nástroj „Select“. 

i. Pravým tlačítkem na nástroj „Select“ -> Rename 

d. Přidání parametrů k nástroji „Select“. 

i. Pravým tlačítkem na nástroj -> Make Variable -> From Parameter 

-> Input Feature. 

ii. Pravým tlačítkem na nástroj -> Make Variable -> From Parameter 

-> Expression. 

 

e. Parametry nastavíme u nově vytvořených bublin.  

i. Pravým tlačítkem -> zakliknout  Model  Parameter.  



 

ii. V našem případě u výstupní vrstvy nástroje, vstupní vrstvy 

nástroje a  podmínky. 

 

2. Nastavení pracovního uložiště pomocí vnitřní proměnné. 

a. Pravým tlačítkem myši na nástroj -> Make Variable -> From Enviroment 

-> Workspace -> Current Workspace. 

 

b. Spojíme vytvořený adresáře pomocí nástroje Connect z horní lišty 

v pracovním prostředí Modelu. 

 

 

c. Při připojení k nástroji „Select“ nastavíme připojení jako „Precondition“  



 

 

d. V nástroji použijeme jako odkaz k tomuto adresáři (databázi) vnitřní 

proměnnou % %. 

e. Mezi procenty použijeme doslovné pojmenování uložiště. 

 

 

 

3. Průnik hasebního obvodu s vrstvou obcí. 

a. Přidáme nástroj „Intersect“ (průnik). 

i. Analysis Tools -> Overlay -> Intersect 



 

b. Nastavení nástroje: 

i. Input Feature: vrstva s výběrem hasebního obvodu a vstupní 

vrstva s obcemi.  

ii. Output Feature Class: %VystupniDatabaze%\Obce_prunik. 

iii. Join Attributes: ALL. 

iv. Output Type: INPUT. 

v. OK 

 

c. Přidání parametru k nástroji „Intersect“. 

i. Parametrem bude vstupní vrstva s obcemi (polygonová). 

d. Přejmenování nástroje, vstupní a výstupní vrstvy.  

 

4. Omezení průniku obcí z důvodu neshodujících se hranic vrstvy hasebních 

obvodů a vrstvy obcí. 

a. Přidáme nástroj „Select“. 

b. Přejmenujeme jej. 

c. Nastavení nástroje: 

i. Input Feature: vrstva průniku obcí s hasebním obvodem. 

ii. Output Feature Class: %VystupniDatabaze%\Obce_prunik_vyber. 



 

iii. Expression: Shape_Area>395330 (nastavení podmínky na rozlohu 

větší než je rozloha nejmenší obce ve Zlínském kraji). 

iv. OK 

 

5. Provedeme zvlášť výběr požadovaných kategorií Jednotek požární ochrany (JPO 

II, JPO III, JPO IV, JPO V, JPO VI). 

a. Přidáme nástroj „Select“. 

b. Input Feature: vrstva s Jednotkami požární ochrany. 

c. Output Feature Class: %VystupniDatabaze%\JOPkategorie. 

d. Expression: “KATEGORIE“ = ‘číslo kategorie‘. 

e. OK 

f. Jako parametr nastavíme vstupní vrstvu s Jednotkami požární ochrany. 

 

 



 

6. Průnik obcí se zájmovými vrstvami. 

a. Přidáme 11x nástroj „Intersect“. 

b. Pokaždé přejmenujeme. 

c. Nastavení nástroje: 

i. Input Feature: vždy upravená vrstva obcí na výběr s rozlohou > 

395 330 m2 (nutné nastavit dvojí spojení – Input Feature 

a Precondition) a zájmová vrstva. 

ii. Output Feature Class:   

%VystupniDatabaze%\odpovidajici_vystupni_vrstva_pruniku. 

iii. Join Attributes: ALL. 

iv. Output Type: INPUT. 

v. OK 

d. Zájmové vrstvy v modelu vstupující do průniku s výběrem obcí: 

i. lesy s křovinatým porostem, 

ii. lesy se stromy, 

iii. železnice, 

iv. silnice, 

v. budovy a bloky budov, 

vi. záplavové území Q100 (stoleté vody), 

vii. výběry kategorií Jednotek požární ochrany (JPO II, JPO III, 

JPO IV, JPO V, JPO VI). 

e. Zájmové vrstvy budou nastaveny jako parametry. 

 

7. Některé průniky je třeba dále upravit: 

a. Sloučit průniky dvou vrstev s lesy do jedné vrstvy. 

b. Omezit výběrem silnice pouze na kategorie dálnice, rychlostní 

komunikace, silnice 1. – 3. třídy.  

 

1. Sloučení vrstev lesů. 

a. Přidáme nástroj „Merge“ 

i. Data Management Tools -> General -> Merge 



 

b. Přejmenujeme jej. 

 

c. Nastavení nástroje: 

i. Input Datasets: vrstva lesů s křovinatým porostem a vrstva 

lesů se stromy. 

ii. Output Dataset: %VystupniDatabaze%\lesy_spojene. 

iii. Zbylé nastavení ponecháme původní. 

iv. OK 

 

2. Výběr kategorií silnic.  

a. Přidáme nástroj „Select“. 

b. Přejmenujeme jej. 

 



 

c. Nastavení nástroje: 

i. Input Features: průnik obcí se silnicemi. 

ii. Output Feature Class: %VystupniDatabaze%\silnice_vyber 

iii. Expression: TYP_K <> 'R' AND ("TYP_K" <> 'Rp' and "TYP_K" <> 

'Rv' AND "TYP_K" <> 'Sn' AND "TYP_K" <> 'Svv' AND "TYP_K" 

<> 'Unsj' AND "TYP_K" <> 'Usj'). 

iv. OK 

 

8. Sloučení vrstev podle vybraného atributu: 

a. Přidáme 10x nástroj „Dissolve“ (sloučení). 

i. Data Management Tools -> Generalization -> Dissolve 

b. Přejmenujeme jej. 

 

 

c. Nastavení nástroje: 

i. Input Features: průnik vybrané vrstvy s vrstvou obcí 

ii. Output Feature Class:  

%VystupniDatabaze%\vybrany_prunik_slouceni. 

iii. Dissolve Field(s): atribut, podle kterého budeme vrstvy slučovat 

(v našem případě název obce). 

iv. Statistics Field(s): atribut, ze kterého můžeme vypočítat 

napříkladsumy, počty, maxima, minima, atd. 

v. Zbytek necháme v původním nastavení. 

vi. OK 

d. Dissolve Field nastavíme jako proměnnou a parametr. 

e. Statistics Field(s) pro jednotlivé vrstvy: 

i. Lesy, záplavové území, budovy:  Shape_Area  SUM 

ii. Kategorie JPO:    KATEGORIE COUNT 

iii. Silnice, železnice:   Shape_length SUM  



 

 

9. Převod na tabulky: 

a. Přidáme 10x nástroj „Table to Table“ (převod na tabulku). 

i. Conversion Tools -> To Geodatabase -> Table to Table 

b. Přejmenujeme jej. 

 

c. Nastavení nástroje: 

i. Input Rows: výstup z nástroje „Dissolve“. 

ii. Output Location: databáze určená pro dílčí tabulky (nesmí se 

shodovat s databází pro mezivýstupy). 

iii. Output Table: natev_vystupni_tabulky. 

iv. Field Maps: upravíme pouze na požadované informace z dané 

vrstvy a atribut určený pro sloučení, nežádoucí smažeme 

označením a křížkem. 

d. Uložiště dílčích tabulek je nastaveno jako proměnná a parametr. Pokud 

zvolíme uložiště jako geodatabázi, budou tabulky ukládány ve formátu 



 

databázových tabulek. Pokud uložiště zvolíme jako adresář, tabulky 

budou ukládány ve formátu dbf. Pro naše účely pracujeme s databází.  

 

TIP!   

Pokud kliknete pravým tlačítkem myši na atribut v okně Field Map, lze tento atribut dle 

libosti přejmenovat pro lepší orientaci ve výsledné tabulce (DOPORUČENO).  

10. Úprava některých hodnot (přepočet m a m2 na km a km2). 

 

a. Přidáme nástroj „Add Field“ (přidání pole). 

i. Data Management Tools -> Fields -> Add Field 

b. Přejmenujeme jej. 

c. Nastavení nástroje „Add Field“: 

i. Input Table: tabulka určená k úpravě. 

ii. Field Name: nový atribut určený k přepočtu hodnot. 

iii. Field Type: DOUBLE. 

iv. Field Alias: viditelný atribut ve výsledné atributové tabulce. 

v. OK 



 

 

d. Přidáme nástroj „Calculate Field“ (výpočet pole). 

i. Data Management Tools -> Fields -> Calculate Field 

e. Přejmenujeme jej. 

f. Nastavení nástroje „Calculate Field“. 

i. Input Table: upravená tabulka o nový atribut. 

ii. Field Name: nově vytvořené pole pro výpočet nové hodnoty. 

iii. Expression: podmínka složená ze znalostí převodů jednotek. 

iv. OK 

 

 



 

g. Přidáme nástroj „Delete Field“ (smazání pole). 

i. Data Management Tools -> Fields -> Delete Field 

h. Přejmenujeme jej. 

i. Nastavení nástroje „Delete Field“ 

i. Input Table: upravená tabulka doplněná o výpočet nové hodnoty. 

ii. Drop Field: původní nepřevedená hodnota. 

iii. OK 

 

 

Úpravy pro sumarizační tabulku zásahových obvodů 

 Vynecháme počáteční výběr hasebních obvodů, průnik s obcemi o výběr obcí 

nad určitou rozlohu. 

 Do průniků se zájmovými vrstvami vstupuje celá vrstva s hasebními obvody. 

 Průnik s obcemi je na stejné úrovni jako ostatní průniky se zájmovými vrstvami. 

 Průnik s obcemi je následně shodně upraven (výběr nad určitou rozlohu). 

 U nástroje „Dissolve“ je vypočítán počet obcí v obvodu: KOD_OBCE COUNT. 



 

MANUÁL PRO TVORBU KONEČNÝCH TABULEK 

 

Vytvoříme opět nový model. 

Model pro jednotlivé hasební obvody 

Počáteční kroky jsou shodné s předchozím modelem. Pro připomenutí znovu uvedeno 

základní nastavení, podrobněji jsou některé kroky rozebrány v předchozím manuálu. 

1. Výběr hasebního obvodu. 

a. Vložíme nástroj „Select“ (výběr) 

i. Analysis Tools -> Extract -> Select 

b. Nastavení nástroje: 

i. Input Features (vstupní vrstva): vrstva s hasebními obvody 

Zlínského kraje. 

ii. Output Feature Class (výstupní vrstva): uložiště nastavíme 

pomocí vnitřní proměnné %VystupniDatabaze% (databáze 

pro mezivýsledky) a vrstvu si výstižně pojmenujeme. 

iii. Expression: “atribut_s_nazvem_hasebnich_obvodu“ =  

‘nazev_hasebniho_obvodu‘ (v našem případě nastavení podmínky 

ne v nastavení nástroje, ale  samostatně jako parametru). 

iv. OK 

c. Přejmenujeme nástroj. 

d. Přidání proměnných a parametrů Input Feature a Expression.  

e. Nastavení pracovního uložiště Workspace pomocí vnitřní proměnné. 

 

2. Průnik hasebního obvodu s vrstvou obcí. 

a. Přidáme nástroj „Intersect“ (průnik). 

i. Analysis Tools -> Overlay -> Intersect 

b. Nastavení nástroje: 

i. Input Feature: vrstva s výběrem hasebního obvodu a vstupní 

vrstva s obcemi.  

ii. Output Feature Class: %VystupniDatabaze%\Obce_prunik. 

iii. Join Attributes: ALL. 

iv. Output Type: INPUT. 

v. OK 

c. Nastavení vstupní vrstvy s obcemi jako proměnné a parametru. 

 

3. Omezení výběru obcí z důvodu neshodujících se hranic s vrstvou hasebních 

obvodů. 

a. Přidáme nástroj „Select“. 

b. Přejmenujeme jej. 

c. Nastavení nástroje: 

i. Input Feature: vrstva průniku obcí s hasebním obvodem. 

ii. Output Feature Class: %VystupniDatabaze%\Obce_prunik_vyber 

iii. Expression: Shape_Area>395330 (nastavení podmínky na rozlohu 

větší než je rozloha nejmenší obce ve Zlínském kraji). 

iv. OK 

4. Sloučení vrstev podle vybraného atributu: 

a. Přidáme nástroj „Dissolve“ (sloučení). 

i. Data Management Tools -> Generalization -> Dissolve 



 

b. Přejmenujeme jej. 

c. Nastavení nástroje: 

i. Input Features: vrstva obcí 

ii. Output Feature Class: 

 %VystupniDatabaze%\vstupni_vrstva_slouceni. 

iii. Dissolve Field(s): atribut, podle kterého budeme vrstvy slučovat 

(v našem případě název obce, ORP a okres). 

iv. Statistics Field(s): atribut, ze kterého můžeme vypočítat například 

sumy, počty, maxima, minima, atd. (Shape_Area   SUM). 

v. Zbytek necháme v původním nastavení. 

vi. OK 

 

5. Převod na tabulky: 

a. Přidáme nástroj „Table to Table“ (převod na tabulku). 

i. Conversion Tools -> To Geodatabase -> Table to Table 

b. Přejmenujeme jej. 

c. Nastavení nástroje: 

i. Input Rows: výstup z nástroje „Dissolve“. 

ii. Output Location: databáze určená pro konečné tabulky (nesmí se 

shodovat s databází pro mezivýstupy ani s databází pro dílčí 

tabulky). 

iii. Output Table: nazev_vystupni_tabulky. 

iv. Field Maps: upravíme pouze na požadované informace z dané 

vrstvy a atribut určený pro sloučení, nežádoucí smažeme 

označením a křížkem. 

d. Uložiště dílčích tabulek je nastaveno jako proměnná a parametr. Pokud 

zvolíme uložiště jako geodatabázi, budou tabulky ukládány ve formátu 

databázových tabulek. Pokud uložiště zvolíme jako adresář, tabulky 

budou ukládány ve formátu dbf. Pro naše účely pracujeme s databází.  

 

6. Upravená tabulka je použita jako podkladová tabulka (vstupní vrstva) 

do vnořeného modelu, který je použit jako nástroj v rámci tohoto modelu. 



 

 

7. Úprava některých hodnot výsledné tabulky. 

 

a. Přidáme nástroj „Add Field“ (přidání pole). 

i. Data Management Tools -> Fields -> Add Field 

b. Přejmenujeme jej. 

c. Nastavení nástroje „Add Field“: 

i. Input Table: tabulka určená k úpravě. 

ii. Field Name: nový atribut určený k přepočtu hodnot. 

iii. Field Type: DOUBLE. 

iv. Field Alias: viditelný atribut ve výsledné atributové tabulce. 

v. OK 

d. Přidáme nástroj „Calculate Field“ (výpočet pole). 

i. Data Management Tools -> Fields -> Calculate Field 

e. Přejmenujeme jej. 

f. Nastavení nástroje „Calculate Field“. 

i. Input Table: upravená tabulka o nový atribut. 

ii. Field Name: nově vytvořené pole pro výpočet nové hodnoty. 

iii. Expression: podmínka složená ze znalostí převodů jednotek. 

iv. OK 

g. Přidáme nástroj „Delete Field“ (smazání pole). 

i. Data Management Tools -> Fields -> Delete Field 

h. Přejmenujeme jej. 

i. Nastavení nástroje „Delete Field“. 

i. Input Table: upravená tabulka doplněná o výpočet nové hodnoty. 

ii. Drop Field: původní nepřevedená hodnota a duplicitní atributy 

vzniklé při joinování (název obcí). 

iii. OK 

j. Spojení výstupní tabulky s nástrojem pomocí Precondition. 



 

Vnořený model 

Vnořený model obsahuje iterátor a nástroj „Join Field“. Vytvořením samostatného 

modelu je zamezeno přepisování řádků ve výsledné tabulce. Model vstupuje jako nástroj 

do jiného modelu. 

1. Vložení iterátoru. 

a. Vložíme iterátor na procházení tabulek („Iterate Tables“.) 

i. Insert -> Iterators -> Tables 

b. Nastavení iterátoru: 

i. Vybereme uložiště dílčích tabulek, které bude procházeno 

iterátorem. 

c. Vložíme nástroj „Join Field“. 

i. Data Management Tools -> Joins -> Join Field 

d. Nastavení nástroje: 

i. Input Table: tabulka vytvořená v předchozím modelu. 

ii. Input Join Field: atribut z podkladové tabulky, na jehož základě 

dojde k připojení. 

iii. Join Table: tabulky z iterátoru. 

iv. Join Field: nemusíme zaznačit. 

v. OK 

 

 



 

 

 

Úpravy pro sumarizační tabulku 

 Rozdíl je v počátku modelu. Podkladovou tabulku tvoříme z celé vrstvy 

hasebních obvodů. Je potřeba změnit atribut určený k joinování . 

 Vnořený model je beze změny. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

MANUÁL PRO TORBU OŘEZŮ VYBRANÝCH VRSTEV 

 

1. Výběr obcí ve Zlínském kraji. 

a. Vložíme nástroj „Select“. 

i. Analysis Tools -> Extract -> Select 

b. Přejmenujeme jej. 

c. Nastavení nástroje: 

i. Input Features: vrstva obcí. 

ii. Output Feature Class: výběr obcí ve Zlínském kraji. 

iii. Expression: “nazev_kraje“ = ‘Zlínský kraj‘. 

 

2. Převod názvu bez diakritiky. 

a. Vložíme nástroj „Add Field“. 

i. Data Management Tools -> Fields -> Add Field 

b. Přejmenujeme jej. 

c. Nastavení nástroje: 

i. Input Table: výběr obcí. 

ii. Field Name: nový atribut. 

iii. Field Type: TEXT. 

iv. Zbytek beze změny. 

v. OK 

 

d. Vložíme nástroj „Calculate Field“. 

i. Data Management Tools -> Fields -> Calculate Field 

e. Přejmenujeme jej. 

f. Nastavení nástroje ve verzi  ArcGIS 10.0. 

i. Input Table: upravená vrstva. 

ii. Field Name: nově vytvořený atribut. 

iii. Expression: replaceDiacritic( unicode(!NAZ_OBEC_P!), True). 

iv. Expression Type: Python. 

v. Code Block:  

def replaceDiacritic(text = "", replaceSpaces = False): 

target = u"áäčďéěíĺľňóôőöŕšťúůűüýřžÁÄČĎÉĚÍĹĽŇÓÔŐÖŔŠŤÚŮŰÜÝŘŽ" 



 

replacer = u"aacdeeillnoooorstuuuuyrzAACDEEILLNOOOORSTUUUUYRZ" 

 

for i in range(0, len(text), 1): 

if text[i] in target: 

text = text.replace(text[i], replacer[target.index(text[i])]) 

 

if replaceSpaces: 

text = text.replace(' ', '_') 

text = text.replace('-', '_') 

 

return text 

 

 

g.  Nastavení nástroje ve verzi  ArcGIS 10.1 a výš. 

i. Input Table: upravená vrstva. 

ii. Field Name: nově vytvořený atribut. 

iii. Expression: remove_accents(!NAZ_OBEC_P!, True). 

iv. Expression Type: Python. 

v. Code Block:  

import unicodedata 

def remove_accents(input_str, replaceSpaces): 

 

    try: 

        input_str = unicode(input_str, "UTF8") 

    except: 

        input_str = unicode(input_str) 

 

    nkfd_form = unicodedata.normalize('NFKD', input_str) 

    only_ascii = nkfd_form.encode('ASCII', 'ignore') 

 

    if replaceSpaces: 

        only_ascii = only_ascii.replace(' ', '_') 

  only_ascii = only_ascii.replace('-', '_') 

 

    return only_ascii 



 

3. Procházení řádků výstupní vrstvy. 

a. Vložíme iterátor pro porcházení řádků vrstvy.  

i. Insert -> Iterators -> Row Selection 

b. Nastavení iterátoru: 

i. Input Table: upravený výběr. 

ii. Group By Field: kód obce a atribut s upravenými názvy. 

iii. OK 

 

4. Ořezávání vrstev 

a. Vložíme zájmové vrstvy: 

i. lesy s křovinami, 

ii. lesy se stromy, 

iii. záplavové území, 

iv. budovy, 

v. obce,  

vi. silnice, 

vii. železnice, 

viii. vodní toky, 

ix. jezera. 

b. Ke každé vrstvě vložíme nástroj „Clip“. 

i. Analysis Tools -> Extract -> Clip 

c. Nastavení nástroje: 

i. Input Features: vybraná vrstva. 

ii. Clip Features: výstup z iterátoru. 

iii. Output Feature Class: nazev vrstvy_%Value% (vnitřní proměnná 

odkazuje na vybrané atributy v rámci iterátoru). 

iv. OK 



 

 

POZOR 

 Model běží až 12 hodin. 

 Vytváří přes 2 700 vrstev. 

Skript na roztřídění ořezů 

 Podrobný popis i s komentáři viz Příloha 6. 

 

  



 

PŘÍLOHA 10 – UŘIVATELSKÁ PŘÍRUČKA 

PŘEDPŘÍPRAVA 

 

Důležitým krokem před samotným nastavením toolboxů je vytvoření pracovních 

databází. Nevhodné využívat stejné databáze (z důvodu funkčnosti modelů). 

1. Vytvořte databázi pro pracovní výstupy (mezivýsledky) 

 Doporučená struktura: 

 Databáze + datasety pro jednotlivé zásahové obvody + 

dataset určený pro všechny zásahové obvody 

ve Zlínském kraji. 

2. Vytvořte druhou databázi na tvorbu mezivýsledků z modelu 

pro sloučení tabulek. 

3. Vytvořte databázi pro dílčí tabulky. 

 Nelze využít datasetů, nutné vytvořit databáze pro každý 

obvod. 

4. Vytvořte databázi pro konečné tabulky. 

 Postačí jedna databáze, do které se budou ukládat všechny 

dílčí tabulky. 

NASTAVENÍ PARAMETRŮ MODELŮ 

 

Každý model je doplněn o nápovědu při otevření rozhraní parametrických 

modelů.  Respektujte prosím pokyny z nápovědy. 

Podrobný popis modelu je uveden v manuálu. 

ČASOVÁ NÁROČNOST 

 

 Jeden model pro tvorbu dílčích tabulek běží zhruba 15 minut.  

 Model, který tvoří dílčí tabulky pro tři až čtyři obvody běží zhruba 45 minut. 

 Jeden model pro tvorbu konečných tabulek běží zhruba 10 minut. 

 Model pro tvorbu konečných tabulek všech zásahových obvodů běží zhruba 

hodinu a půl. 

 Model pro tvorbu ořezů běží zhruba 12 až 13 hodin. 

 Skript pro tvorbu mxd a pdf běží 2 hodiny. 

 

 

 

 

 

 

 

 

 


